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1.  Important Notes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
This manual uses the following abbreviations as summarized in Table 1: 
 

DEM Digital Elevation Model 
DSM Digital Surface Model 
DTM Digital Terrain Model 
GSD Ground Sampling Distance 
LUT Look-Up Table 
EO Exterior Orientation 
GCP Ground Control Points 
RPC Rational Polynomial Coefficient 

Table 1: Abbreviations. 

This symbol indicates a tip or helpful information. Following this 
advice will lead to better results and performance. 

This symbol indicates an important notice.  Failing to follow the 
notice could lead to unexpected or incorrect results. 
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2. Overview 

Correlator3D™ software is a patented end-to-end photogrammetry solution for the generation of 
high-quality geospatial data from satellite and aerial imagery, including UAVs.  It builds on unique 
computer vision algorithms that significantly differ from traditional photogrammetry techniques.  
Powered by GPU technology and multi-core CPUs, Correlator3D™ ensures matchless processing 
power to support rapid production of large datasets.  
 
Correlator3D™ consists of the following modules: 
 
- Aerial Triangulation: exterior orientation correction and camera calibration 
- DSM Generation: generation of digital surface models and point clouds 
- DTM Extraction: extraction of digital terrain models 
- DEM Editing: manual editing of DEMs 
- Orthorectification: creation of orthophotos and true orthos 
- Mosaic Creation: stitching orthophotos together creating a mosaic 
- Mosaic Editing: manual editing of mosaic seamlines 
- Feature Extraction: semi-automated collection of 3D features 
 
 
The software also provides other tools including: 

 
­ Automated Workflow: automatic execution of Correlator3D™ workflow 
­ GCP File Creation: semi-automatic tool for creating and editing GCPs 
­ NDVI Map Creation: compute the normalized difference vegetation index 
­ Change Detection: identification of 3D changes 
­ DEM Merging: stitching of DEM patches 
­ DEM Inspection: generation of statistics about DEM quality 
­ Point Cloud Colorization: colorization of a point cloud using a mosaic 
­ DEM Contour Extraction: extract contour lines from a DEM 

 

 
DSM 

 
DTM Mosaic 

 
Figure 1: Sample geospatial data. 

 
The following sections describe, in detail, the different functionalities, uses, and guidelines of the 
software, to ensure optimal results. 
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3. System Requirements 

Correlator3D™ has been designed to operate on standard PCs.  However, it consists of state-of-
the-art software and as such, requires a recent computer.  A great portion of the processing is 
performed directly on the graphics card, which is part of what allows Correlator3D™ to generate 
geospatial data so rapidly.  The supported cards must feature an NVIDIA® GeForce graphics 
processor. 
 
It is therefore recommended to use Correlator3D™ on a PC that meets or exceeds the 
specifications in Table 2: 
 
 

Component Description 
CPU Intel® Core™ i5 processor or higher 
GPU Graphics card with an NVIDIA® GeForce 9 GPU (G92) or higher, with 1GB RAM or 

higher (note that some Quadro, Tesla, and Tegra cards also feature a GeForce  
GPU), or with an AMD Radeon™ R9 GPU or higher, with 1GB RAM or higher. 

RAM 8GB or higher 
OS Windows 7, 8 and 10. Correlator3D™ is a 64-bit application. 

Table 2: Recommended specifications for running Correlator3D™. 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         8 
   

4. Data Requirements  

Correlator3D™ requires different types of data to be able to perform its processing and can 
produce several kinds of outputs.  As a result, it expects and generates data using specific data 
types. Table 3 summarizes the supported file formats.  
 

Data Type Supported Formats File Extensions 
DEM SimActive Model Format (SAMF) 

GeoTIFF 
Arc/Info ASCII Grid 

.smf 

.tif 

.asc 
3D Constraint ESRI Shapefile  

Microstation DGN 
.shp 
.dgn 

Image Types TIFF / BigTIFF / GeoTIFF 
JPEG Compliant 
JPEG2000 
Windows Bitmap 

.tif 

.jpg 

.jp2 

.bmp 
 NITF .ntf 
Mosaic Definition File SimActive Format .sbd 
Tile Definition SimActive Format .tdf 
Ground Control Points SimActive Format .gcp 
Orthorectified Images GeoTIFF (BigTIFF) 

TIFF (BigTIFF) World Format 
.tif, 
.tif, .tfw 

Support File for ADS SOCET SET support file .sup 
RPC for Satellite RPC Model file .rpc, .rpb, .xml, .txt 
Image Tiles for Satellite Tile Model file 

DIMAP 
.til 
.xml 

SimActive Script SimActive Script Format  .spt, .txt 
Geoid GTX Format .gtx 
Project File SimActive Format .c3d 
3D Features ESRI Shapefile .shp 
Contours ESRI Shapefile 

AutoCAD 2000 DXF 
.shp 
.dxf 

Interior/Exterior 
Orientation File 

SimActive Format .ieo 

Table 3:  Supported file formats. 
 

4.1 Sensor Types 

Correlator3D™ supports the following types of sensors: 
 UAV / Medium / Large format camera systems 
 Satellite sensors using the RPC model 
 Leica’s ADS pushbroom sensors 
 VisionMap A3 camera systems 
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These four sensor types function in a similar manner, but require different parameters when 
creating a project. The following flowchart describes the workflow of Correlator3D™. Note that 
the workflow is sensor-dependent. 

 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 2:  Correlator3D™ workflow. 
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4.2 Input Image Formats 

Supported formats are summarized in Table 4. 
 

Image Type Data Format 
TIFF, BigTIFF and GeoTIFF 8 or 16 bits per channel 

1, 3 or 4 channels 
JPEG in TIFF 8 or 12 bits per channel 

1, 3 or 4 channels  
LZW  in TIFF 8 or 16 bits per channel 

1, 3 or 4 channels 
JPEG 8 bits per channel 

1 or 3 channels 
JPEG2000 8 or 16 bits per channel 

1, 3 or 4 channels 
NITF 8 or 16 bits per channel 

1, 3 or 4 channels 
Windows Bitmap 8 bits per channel 

1, 3 or 4 channels 
Table 4: Supported input image formats 

 
TIFF and GeoTIFF images are supported in both interleaved (RGBRGB) and pixel ordered (RRGGBB) 
formats. 
 

4.3 DEM Format 

The DEM should have square cells for both the GeoTIFF and Arc/Info ASCII Grid formats.  This 
means that cell dimensions in X and Y should always be the same.  Also, elevation values in 
GeoTIFF files should be expressed as 32-bit floating point numbers.  
 

4.4 Orthophoto Format  

Orthophotos can be generated in the Tiled TIFF format with overviews to maximize system 
performance during their subsequent exploitation using GIS software.  However, the user should 
keep in mind that in general, more basic image viewing software do not support images in the 
Tiled TIFF format with overviews.  Orthophotos are produced in one of the following formats: 
 

­ 1 channel 8-bit or 16-bit (panchromatic) 
­ 3 channels 24-bit or 48-bit 
­ 4 channels 32-bit or 64-bit 

 

4.5 3D Constraints 

A 3D constraint can be supplied to the DSM generation and DTM extraction modules to force 
specific elevation values in the output DEM. Such a 3D constraint must be provided in the form of 
a vector file (ESRI Shapefile or Microstation DGN), which may contain points, lines or regions. 
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Elements in the constraint file must contain elevation (3D) data. 
 

4.6 3D Features 

Existing 3D features can be supplied to the software. These must be in an ESRI Shapefile (.shp) 
and must support storage of elevation data, i.e. features must have a z-component. 
 
 

4.7 Coordinate Systems  

Correlator3D™ requires the projection to be specified when creating a project. The user specifies 
the projection details as shown in Figure 3.  
 

 
Figure 3: Projection dialog. 

 
Four options are presented to the user.  A predefined list of the most common projections is 
available.  Otherwise, the user may specify a custom projection, specify an EPSG code or use a 
Proj.4 projection definition.  If using the EPSG or Proj.4 options, please refer to the official website 
for specific values: http://spatialreference.org/ 
 
Although mandatory for satellite, ADS and A3 sensors, the projection is optional for 
UAV/medium/large format sensors, and can be ignored by pressing the “Ignore” button as shown 
in Figure 3.  Note that the rotation system supported by Correlator3D™ is photogrammetric 
(omega, phi and kappa) and that the geographic coordinate system (i.e. latitude/longitude) and 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         12 
   

navigational angles (i.e. roll, pitch and yaw) are converted when importing EO data during project 
creation.  If the user chooses to ignore the projection, then no projection information will be saved 
in the GeoTIFF files.  
 
For a given project, the DEM and exterior orientation parameters used should thus be expressed 
in the same coordinate system (including the same projection, datum, geoid and units).  
 
EPSG or Proj.4 values representing a geographic coordinate system (latitude/longitude) are not 
supported. 
 
Units are specified along with other projection information. It is very important that the units 
are specified correctly. 
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5. Visual Interface 

Correlator3D™ is designed for ease of use, featuring a simple visual interface. The main window 
serves to load, save, and display DEMs, mosaics, orthos, images, GCPs, and AT results. 
Additionally, it provides access to the different software functionalities and tools. At the core 
enabling this user experience is the project tree, further described in the corresponding section. 
 

 
Figure 4: Correlator3D™ main window. 

 
 

5.1 Multilingual User Interface 

Correlator3D™ can be operated in different languages, including English, French, Japanese, and 
Chinese. The user can select the language at any time by accessing the corresponding option in 
the General Settings dialog from the File menu. Note that the language change is only applied 
once the software is restarted. 
 
 

5.2 Project Tree 

The project tree displays the project information as a hierarchical structure on the user window. 
The tree is used to perform multiple functions: modify the visibility of an overlay using a checkbox, 
save results, add data to the project, etc. It allows the user to seamlessly transition between data 
within each project. When the cursor is placed above an item listed in the project tree, contextual 
buttons appear. The following subsections describe each aspect of the project tree. 
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5.2.1 Images 
 
At the top of the project tree are the “Images”. This item is filled with parameters given during 
the project creation. When selecting the “Images”, the camera(s) used in the project appear with 
their corresponding image footprints if a DEM is loaded. It is possible to have more than one 
camera within each project, and consequently, within the project tree.  
 
Double-clicking on a camera will allow the user to see its associated flight line(s). The user has the 
option to select which flight lines or images are to be processed in corresponding steps using the 
contextual buttons. With this, flight line and images can be disabled; they will not be considered 
while generating a DSM or orthos. Moreover, the checkboxes are used to toggle visibility in the 
main window of the corresponding item (image, flight lines, or complete image set). 
 
In the AT module, all images included in the project are considered; enable/disable have no impact 
and cannot be changed in this mode. 
 
When a DEM is loaded, the image footprints on the ground are displayed. This function can be 
turned on and off at the user's preference. 
 
When images are selected using the tree, the image positions are displayed as arrows overlaid on 
the DEM.  This is very useful when ensuring that both the imagery and 3D data span the same 
region.  Note that each arrow indicates the top of the image.  Flight lines and their direction are 
also displayed as dashed lines with arrows. 
 
When the cursor is placed over an arrow, a tooltip shows the name of the corresponding image. 
The user can also right-click on the image position to display the image in a separate window. The 
image will be rotated following its kappa-angle value. Panning is performed by clicking and 
dragging with the middle (wheel) mouse button while zooming can be performed using the mouse 
wheel. Note that several  images can be displayed simultaneously. 
 
Within the aerial triangulation module, the arrows may be replaced by color disks to allow a quick 
assessment of the quality of the bundle adjustment process. Please refer to section 7.1.5 for 
details. 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         15 
   

 
Figure 5: Image window. 

 
 

5.2.2 GCP 
 
An existing GCP file can be added to the project directly using the project tree. There is also the 
option to remove the GCP file from a project. In order to create a GCP file, the user can go into 
the AT module. Similar to the aforementioned option, the project tree can be used to toggle the 
GCP visibility using the checkboxes. 
 
Correlator3D also allows the user to specify check points. GCPs and check points are stored in the 
same GCP file, but the project tree displays them in two distinct subcategories of GCPs. GCPs and 
check points are only considered when performing bundle adjustment, but can be used to visually 
assess quality of the DSM, DTM, and mosaic. Please refer to sections 7.1.2 and 10.4 for further 
details. 
 

5.2.3 AT 
 
Please refer to section 7.1 for details. 
 

5.2.4 DEM 
 
The project tree simplifies working with DEMs as a DEM can be loaded directly onto it. Select “Add 
a DEM to project”, by placing the cursor over the “DEM” item in the project tree. More than one 
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DEM can be a part of the project. However, at any given time, only one DEM can be displayed. 
The ability to toggle between multiple DEMs is possible through the project tree using the 
checkbox for each DEM. It is also possible to remove a DEM by clicking on the “X” when placing 
your mouse over the respective DEM. 
 
Once the data is read, it will be displayed in the window. Two display styles are available for 
viewing elevation data: color and grayscale. 
 
If the color display style is selected, elevation values are mapped from blue to red (through green 
and yellow) according to the minimum and maximum values found in the data: low elevation 
values will be displayed in blue or green, middle values in yellow and high values in red. 
 
If the grayscale display style is selected, elevation values are linearly mapped from black to white 
according to the minimum and maximum values found in the data: low elevation values will be 
displayed in dark colors while high values will appear in light colors. 
 
The display style can be changed by selecting “Display Style->Color” or “Display Style->Grayscale” 
in the “View” menu. 
 
Colors can be mapped from the minimum and maximum elevation values visible on the screen.  
The latter case is called “stretch” mode and can be enabled or disabled by selecting “Display Style-
>Stretch” in the “View” menu. 
 
Subtle variations in elevation values can be highlighted by selecting the “Shade DEM variations” 
feature, which simulates lighting and shadows. This feature can be enabled or disabled by 
selecting “Display Style->Shade” in the “View” menu. 
 
When a DEM file is loaded, a legend is visible at the left of the main window. This legend shows 
the color mapping currently used for displaying the elevation data. Minimum and maximum 
values are displayed with a line indicating the “0” value, if relevant. When the cursor is moved 
over the DEM, a horizontal bar moves up and down over the legend providing a visual cue for the 
elevation under the cursor. Precise elevation and coordinates of the location under the cursor are 
available in the right part of the status bar. The legend can be shown or hidden by selecting 
“Legend” in the “View” menu. 
 
DEMs can be saved by clicking the contextual button in the tree. 

 

5.2.5 Orthos 
 
With the project tree, the user can toggle the visibility of each generated ortho with its checkbox. 
It is possible to directly delete all the orthos from the project by hovering over the “Orthos” item 
on the project tree and clicking on the “X”. The user can also specify a new or existing folder for 
orthos. In order to do this, place the mouse over the “Orthos” and select the “+” icon to open or 
set a new ortho folder. Note that generating orthos without specifying a new folder will delete 
the previously stored orthos from the folder. 
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The user has the option to select which orthos are to be processed in mosaic creation using the 
contextual buttons. With this option, orthos can be disabled; they will not be considered while 
generating a mosaic. 

5.2.6 Mosaic 
 
The user can toggle the visibility of the mosaic using the project tree by using the checkbox. It is 
possible to directly delete the mosaic from the project by hovering over the “Mosaic” on the 
project tree and clicking on the “X”. The user can also specify a new or existing folder for the 
mosaic. In order to do this, place the mouse over the “Mosaic” item and select the “+” icon to 
open or set a new mosaic folder. Note that generating the mosaic without specifying a new folder 
will delete the previously stored mosaic from the folder.  

5.2.7 Reference 
 
Reference orthos are orthos that were created outside of a project and are used for quality 
assessment. The AT module can also use the reference orthos along with a DEM as horizontal and 
vertical reference data when GCPs are not available. 
 
The functionality of the tree view with respect to the reference orthos is the same as the one 
described in section 5.2.5. Note that disabled reference orthos will not be considered while 
performing a bundle adjustment with reference imagery. 

5.2.8 Contour 
 
The user can toggle the visibility of the generated contour lines using the project tree and its 
checkbox. Existing contours can be added by placing the cursor over the “Contour” item in the 
project tree and selecting “Open contour”. Note that more than one contour can be part of the 
project. It is also possible to remove a contour by clicking on the “X” when placing your mouse 
over the respective contour item. Contours can be saved by clicking the contextual button in the 
tree. 
 
When a contour is selected using the tree, it is displayed as lines in the main window.  Hovering 
the cursor over a specific line will pop up the corresponding elevation. It is also possible to click 
on a specific line to highlight it. 
 

 

5.3 Properties 

The project tree includes a window that displays the properties of a selected object (e.g. GCP, 
camera, images, DEM, orthophotos). The tool is beneficial as it assists in the assessment of 
metadata, such as the camera calibration, image position, GCP type, etc. The information the 
property window displays is dependent on the type of object selected.  
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5.4 Zooming and panning 

The main window of Correlator3D™ supports advanced zooming and panning capabilities.  Data 
caching and automatically triggered refreshes are performed to offer both rapid and fluid 
response, while displaying the most accurate information available. Fast results are obtained even 
for huge projects at low memory costs. When working with large files, hard disk performance can 
limit the speed at which information can be displayed. In such situations, Correlator3D™ will 
temporarily display a less accurate version of the data while it is being loaded. The accurate 
version will be displayed shortly afterward, as soon as available. 
 
This allows the user to continue panning and zooming while data loading is performed and ensures 
a fast response at any given moment. 
 
Panning is performed by clicking and dragging with the left or middle (wheel) mouse buttons.  
 
Note that during DEM editing, only the middle (wheel) button is supported for panning.  
 
Zooming can be performed in multiple ways. The simplest and most intuitive way is to use the 
mouse wheel. If the mouse does not include a wheel, the options “Zoom->Zoom In” and “Zoom-
>Zoom Out” in the “View” menu will provide the same results. 
 
The “Zoom to region” feature lets the user specify a rectangular area. Zoom and pan operations 
are then computed to show the selected area as large as possible and centered onscreen. The 
“Zoom to region” feature is available by selecting “Zoom->Zoom to region” in the “View” menu. 
 
At any time, the user can return to the default view by selecting “Zoom->Home” in the “View” 
menu. The default view displays the entire project centered onscreen. 
 
 

5.5 Picture-in-Picture 3D Viewing 

Correlator3D™ features picture-in-picture (PiP) 3D viewing capability.  The PiP brings a 3D 
rendered view of projects through an inset window, visible at all times to streamline processing 
and editing. The interactive viewing capability allows display of image locations and associated 
viewing pyramids, as well as DSMs, DTMs, orthophotos and mosaics.  Ground control points, check 
points, and aerial triangulation results are displayed in 3D to facilitate quality control. The PiP 
allows a 3D visual assessment of data and results throughout the entire production workflow, 
including real-time modifications displayed during DEM editing. 
 
The PiP window always reflects in 3D what is currently displayed in 2D in the main view. For 
example, zooming in the main window will result in cropping the data shown in the 3D view. 
Therefore, users willing to inspect a feature in more detail should first zoom in the main window, 
and then interact with the PiP window. 
 
At any time, the 2D and 3D views can be swapped by pressing the corresponding button in the 
toolbar. 
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The size of the PiP window can be set to small, medium, or large in the in “View->3D View” menu. 
Users can also have the 3D view in its one window by selecting “3D View->Window” in the “View” 
menu. 
 
Rotation in the PiP window is performed by clicking and dragging with the left mouse button. 
Zooming can be performed by using the mouse wheel, while panning is done by clicking and 
dragging with the middle (wheel) mouse button. The left button of the mouse can be used to 
select an object like an image pyramid to see its footprint. 
 
Users can always reset the view point to its original state using the corresponding button in the 
toolbar. 
 
Elevation values of objects being displayed in the 3D view can be exaggerated or suppressed to 
facilitate data analysis. To achieve this, users can repeatedly press the corresponding buttons in 
the toolbar. 
 
 
 

5.6 Scale 

The user can also zoom the current view to a specified scale.  For example, to make 1 centimeter 
on the screen to be equivalent to 1 kilometer of ground truth, one would enter a scale of 100,000 
(this is the number of centimeters in a kilometer). 
 
A scale indicator is located near the bottom of the legend. The indicator can be shown or hidden 
by selecting “Scale” in the “View” menu. The scale is dynamically adjusted during a zoom 
operation. 
 
 

5.7 Status Bar 

The status bar provides various types of information, including the sensor type, the DEM 
horizontal resolution, the coordinates of the cursor and the elevation at the cursor’s location. The 
sensor type is either “UAV/Medium/Large Format”, “Satellite”, “ADS” or “VMA3” and indicates 
the current project type. The DEM resolution displays the resolution of the DEM written in the 
file. Unlike the scale, it is invariant to zooming operations. Coordinates are refreshed while the 
cursor is moved over the DEM and the elevation under the cursor is displayed only when available. 
The status bar can be shown or hidden by selecting “Status Bar” in the “View” menu. 
 
 

5.8 Profile 

The Profile tool generates a vertical profile of the DEM over a user-specified path. The path 
consists of a series of connected linear segments.  Once a path is specified, Correlator3D™ opens 
a new window containing the vertical profile. The profile is generated by sampling the DEM and 
contains two different representations simultaneously. 
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The first representation is an area chart shown in light blue. It shows the real elevation value for 
each sample based on a nearest neighbor approach for samples falling between two values of the 
DEM. It provides a discrete representation that is well-suited for visualizing surfaces that are 
highly non-continuous (e.g. urban areas). 
 
The second representation is a smooth dark blue line super-imposed over the previous 
representation. This time, a bilinear interpolation technique is used to obtain the sample values. 
The representation is better suited for visualizing areas where the terrain is continuous (e.g. rural 
areas). 
 
In the profile windows, vertical blue lines show the delimitation of each linear segment of the 
path. 
 
When the mouse is moved over the profile, a blue circle located on the interpolated profile follows 
the mouse motion. XY coordinates and elevation values associated with this blue circle are 
automatically updated and shown in the lower right corner of the profile window. A similar circle 
appears and moves synchronously in Correlator3D™’s main window over the user-specified path 
to show the exact location corresponding to the mouse position in the profile view. 
 
A “stretch” button located in the status bar enables or disables the stretch mode. When enabled 
(default), the profile is stretched to take the entire size of the window, but the aspect ratio is not 
respected. When disabled, square aspect ratio is used, ensuring that the same number of pixels 
in the x or y dimensions correspond to the same physical dimension in DEM units.  
 
By right-clicking on the profile, the user can save an image of the profile in a file or to the clipboard. 
 

 
Figure 6: Profile window. 
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5.9 Volume 

The Volume tool measures a volume over a user-specified selection and a reference elevation. 
The user begins by selecting the area in which the volume is to be calculated. Once a path is 
specified, Correlator3D™ opens a window for the user to select a reference elevation for the 
volume to be computed. There are five types of reference elevations: 
 

- Interpolate DEM at selected boundary: obtain volume by interpolating DEM values 
present at the chosen boundary 

- Use fixed elevation: obtain volume from a specified height  
- Remove constant offset (dig): obtain volume by removing an offset value 
- Add constant offset (fill): obtain volume by adding an offset value 
- Use reference DEM: obtain volume by selecting a reference DEM 

 
These options give the user flexibility in the volume type they can calculate. 
 
The following statistics appear in the properties windows on the left once the process is complete: 
 

- Volume (Cut): the volume measured between the reference elevation, and the terrain 
above 

- Volume (Fill): the volume measured between the reference elevation, and the terrain 
below 

- Terrain area: the area covered by the selection, considering the terrain morphology. This 
can be visualized as the size of the sheet you would require to drape the terrain 

- Orthogonal area: the area covered by the selection, not considering the terrain elevation 
- Volume coverage: percentage representing the coverage of the selection used to measure 

the volume, with no consideration for the undefined elevation values. The user should 
ensure that this value is always close to 100%. The value may indicate that the reference 
DEM being used does not overlap completely with the current DEM, or that the software 
was not able to completely interpolate at selected boundary (because too many vertices 
were falling outside the model). 
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Figure 7: Volume window. 
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6. Project Creation 

 
The simplistic design and interactive user interface is made possible through the creation, and 
use, of projects. A project within Correlator3D™ consists of a file with information about the 
location of all the input and output data: EO data, camera calibration, AT data, projection, images, 
DEMs, GCP, orthos, mosaic and reference orthos. The purpose of the project is to centralize 
information for ease of use. Part of this information must be specified during project creation. 
 
The project creation wizard is used to create a project in Correlator3D™. As the wizard 
incorporates all supported sensor types, the user does not have to be concerned with the specific 
sensor type for the full photogrammetry workflow. A project type must be simply selected from 
one of five options, and proceed with the required steps. 
 
Once a project has been created, it can be closed and accessed at a later time. A project can be 
moved from one location to another, as long as the file hierarchy is preserved on disk (e.g. one 
folder with the project file and all images, orthos). 
 
To save the main file of a project, the user can select “Save Project As” within the File menu. This 
will not change or move the other files, only the main one. 
 
There are five types of projects differentiated by the sensor type and image size. These include: 
UAV, Medium/Large Format, Satellite, ADS, and A3. The following sections describe the steps to 
create a project for each of the listed project types. As the UAV and Medium/Large Format project 
types only differ in image size, they are grouped together. 
 

 
Figure 8: Project type. 
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6.1 UAV / Medium / Large Format 

The UAV/medium/large format imagery refers to digital images and scanned films. The difference 
with each is based on the image size. The UAV format is used for digital images smaller than or 
equal to 40MP. The medium/large format is used for images greater than 40MP, and for scanned 
films. 
 
UAV/medium/large sensor the user should ensure that the overlap between adjacent images is 
appropriate to ensure optimal results. The endlap (i.e. the overlap between successive images) 
should be at least 60% of the image size, but also should be as close as possible to that value. In 
terms of the sidelap requirements (i.e. the overlap between images from adjacent flight lines), it 
is recommended to use a value between 20% and 30%.  Note that for low-altitude flights, the 
endlap should be approximately 80% and the sidelap 50% to minimize occlusion effects from one 
image to the other. 
 
If images were collected with an endlap greater than 75%, half of the images can be disabled (i.e. 
one out of every two images) from the image list.  This will not only reduce the processing time, 
but will also lead to more accurate results. Note that for image orthorectification,  the overlap of 
the resulting orthorectified images can be specified. 
 

6.1.1 Step 1 - Image Selection 
 
The user selects the images to be processed in the project. This is done by adding the images and 
their corresponding EO data in the wizard. Images can be added individually, or through a 
complete folder using the appropriate button. Once they are added, the software automatically 
requests EO data (please refer to section 10.1 for further details). If EXIF information is present, 
the software can use it to generate the EO data, though it is not mandatory. The user has the 
option to import a text file, or a legacy SimActive EO file. Projection information will be asked for 
after this dialog (please refer to section 4.7 for further details). 
 
More than one camera can be added to a project. If there is more than one camera, those cameras 
can either belong to the same group (e.g. a multi-head camera systems), or to different groups 
(e.g. an area was flown by two different cameras that are not attached together). This can be 
performed through the drop-down menu under “Camera” and  “<Add a new camera>”. The 
camera name must be inputted and the group selected based on the aforementioned description. 
 
The user has the ability to remove all selected images using the “Clear” button, choosing a new 
set of images instead. Specific images can be removed from the dataset using the “X” button on 
the right of the list of selected images.  
 

6.1.2 Step 2 – Camera Parameters 
 
Camera parameters for all cameras of the project must be specified. The user can import a legacy 
SimActive camera file. Alternatively, the software can detect the values automatically, including 
the focal length and pixel size. “Digital – Polynomial” is the suggested type for non-metric cameras 
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similar to those normally used on UAVs. More information on different camera calibration types 
can be found in section 13.1.1.1. If the user is working with scanned films, the fiducial detection 
tool will be shown (please refer to section 10.3 for further details). 
 
Although parameters can vary from one camera to the other, only one calibration type is 
supported for a given project.  For scanned films, if the dimensions of images in pixels vary, then 
the smallest width and height values observed should be specified.  Note that these minimum 
width and height values may come from two different images. 
 

6.1.3 Step 3 – Project Parameters 
 
In this step, the user defines the project location by clicking on the “…” button. There is the option 
to specify a projection, however, it cannot be different than the one selected for the images in 
Step 1.  
 
The other project parameters are optional. The “Seed DEM” option allows the user to create 
(please refer to section 10.2 for further details) or specify (e.g. SRTM) a seed DEM. 
 
With the “GCP File” option, the user can specify a file containing GCP and check point information. 
The file can be an existing one or it can be created by importing data from a text file (please refer 
to section 10.4 for further details). 
 
The “Reference Orthos” option lets the user browse and select a folder containing the reference 
orthos. 
 
Both GCPs and reference orthos can be specified during project creation. However, when 
performing bundle adjustment, the user will need to select a single ground reference.  
 
 

6.2 Satellite 

6.2.1 Step 1 - Image Selection 
 
The metadata of a satellite image is stored in its corresponding RPC file. This file comes in several 
formats, all of which are supported by Corrleator3D™. When creating a project, the user must 
specify the input RPC files of the images to be processed. Correlator3D™ automatically parses 
these files to recover the satellite parameters. For large satellite images, the images may be tiled 
and referenced by a TIL file. This TIL file will be required as an input. Only one (1) RPC file is needed 
per TIL file. The project creation wizard will automatically suggest an image file when an RPC file 
is selected first.  
 
The user has the ability to remove all selected images using the “Clear” button, choosing a new 
set of images instead. Specific images can be removed from the dataset using the “X” button on 
the right of the list of selected images. 
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6.2.2 Step 2 - Image Pairing 
 
In order to generate a DSM using overlapping satellite images, the user must specify image pairs. 
Each pair will be used to generate a corresponding DSM, with the results merged at the end of 
the process.  
 
To construct a pair, select each of the images to be paired using the drop-down menu, and click 
on “Add”. A star (*) before the name of the image in the drop-down menu indicates that the image 
has not been used in any pair thus far.  
 
This step can be skipped if no DSM is required. 

6.2.3 Step 3 – Project Parameters 
 
In this step, the user defines the project location by clicking on the “…” button. It is mandatory to 
specify a projection. The projection can be specified by selecting a Seed DEM with a valid 
projection in it. 
 
The other project parameters are optional. The “Seed DEM” option allows the user to create 
(please refer to section 10.2 for further details) or specify (e.g. SRTM) a seed DEM. 
 
With the “GCP File” option, the user can specify a file containing GCP and check point information. 
The file can be an existing one or it can be created by importing data from a text file (please refer 
to section 10.4 for further details). 
 
The “Reference Orthos” option lets the user browse and select a folder containing the reference 
orthos. 
 
Both GCPs and reference orthos can be specified during project creation. When performing bundle 
adjustment, the user will need to choose which ground reference to use as they cannot be used 
simultaneously.  
 
 

6.3 ADS 

6.3.1 Step 1 - Image Selection 
 
The metadata of an ADS image is stored in a standard SOCET SET support file. This support file is 
an ASCII file that uses keywords. When creating a project, the user must specify the support files 
of the images to be processed. Correlator3D™ automatically parses these files to recover the 
names of the images, the camera calibration files, and the exterior orientation data. Therefore, 
the user must make sure that all file names and paths specified in the support file are valid. 
 
In the ADS support files, paths containing spaces are not valid. 
 
Correlator3D™ only processes level 1 (L1) imagery for ADS sensors. 
 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         27 
   

6.3.2 Image Pairing 
 
In order to generate a DSM using ADS imagery, the user must specify image pairs. Each pair will 
be used to generate a corresponding DSM, with the results merged at the end of the process.  
 
To construct a pair, select each of the images to be paired using the drop-down menu, and click 
on “Add”. A star (*) before the name of the image in the drop-down menu indicates that the image 
has not been used in any pair thus far. This step can be skipped if no DSM is required. 
 
 
Better results in ADS mode will be achieved if the angle between the sensors is small (i.e. forward-
nadir or nadir-backward). Using the pair forward-backward is likely to generate noisy or erroneous 
results due to occlusions (objects visible in one image might not be visible in the other). 
 

6.3.3 Project Parameters 
 
In this step, the user defines the project location by clicking on the “...” button. It is mandatory to 
specify a projection for an ADS project. The projection can be specified by selecting a Seed DEM 
with a valid projection; it must correspond to the one specified in the support files. The Seed DEM 
(like SRTM) is optional, but highly recommended. The user can create a flat Seed DEM (refer to 
section 10.2 for further details). 
 
 

6.4 A3 

6.4.1 Step 1 - Image Selection 
 
Each VMA3 frame is stored in its own folder along with files containing metadata. When creating 
a project, the user must specify a VMA3 frame folder containing all frames to be processed. 
 
Correlator3D™ only processes Super Large Frame (SLF) imagery for VMA3 sensors. 
 

6.4.2 Project Parameters 
 
In this step, the user defines the project location by clicking on the “...” button. It is mandatory to 
specify a projection for an ADS project. The projection can be specified by selecting a Seed DEM 
with a valid projection in it. The Seed DEM (like SRTM) is optional, but highly recommended. The 
user can create a flat Seed DEM (refer to section 10.2 for further details). 
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7. Data Generation 

 

7.1 Aerial Triangulation  

Correlator3D™ includes an aerial triangulation (AT) module for UAV/medium/large format 
sensors and satellite sensors, which automatically improves exterior orientation values and 
camera calibration parameters from the image data.  It is therefore recommended to perform this 
process on every project to ensure the quality of the geospatial products generated from the 
imagery. The software requires as a minimum overlapping aerial images, coarse GPS 
measurements, and basic camera parameters. 
 
It is worthwhile to spend time on the AT step, as it will help save significant processing time on 
subsequent steps.  
 
To enter this mode, the user must select “Aerial Triangulation” in the “Module” menu. Aerial 
triangulation should be performed in the following order: 
 

1. Tie Point Extraction 
2. GCP Creation (if required) 
3. Tie Point Editing (if required) 
4. Bundle Adjustment 
5. Quality Assessment 
6. Image List Filtering (if required) 
7. Coarse DEM Extraction (if required) 

 
 

7.1.1 Tie Point Extraction 
 
The first step is to extract tie points, which is performed automatically. A tie point is an image 
feature that is visible in two or more images. 
 
Correlator3D offers two types of tie point extraction: standard and exhaustive. The standard 
extraction type is suitable for most projects, while the exhaustive type is better fitted for 
challenging datasets with suboptimal inputs.  
 
Exhaustive tie point extraction is usually slower than standard tie point extraction. It is suggested 
to use the exhaustive type only when the standard one does not generate optimal results (e.g. 
several images that are not connected to others). 
 
If reference orthos are present, the tie point extraction process will also extract points in those 
images, even if their ground sampling distance is different. Note that these observations will be 
used during bundle adjustment only if the Ground Reference option is set to “Reference Orthos”. 
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Compared to bundle adjustment, the tie point extraction process is the most time consuming. 
If the user needs to perform numerous bundle adjustments on the same project, then tie points 
do not need to be recalculated each time. 
 
For best performance, the user should ensure to have both a GPU and CPU OpenCL enabled 
devices. Most graphics card drivers include OpenCL support. However, special drivers may need 
to be installed to enable OpenCL on the CPU. The CPU manufacturer can be consulted for more 
details. 
 

7.1.2 GCP Creation 
 
Next, the user must decide whether to use ground control points (GCP).  Although not required 
for relative accuracy, ground control points are necessary for absolute accuracy. The quality of 
the ground control points will have a strong impact on the results.  Ground control points have 
two benefits. First, they ensure that there is no global spatial offset (i.e. xyz translation) in the 
refined values. Second, they provide another means to validate the residual error of the refined 
values.  
 
The user can also create check points. These are special GCPs that will not be considered during 
bundle adjustment, but for which statistics and reports will be generated. Check points are used 
to assess the quality of the bundle adjustment using an independent data set. 
 
The GCP Editing tool helps the user locate GCPs in the images by selecting the best image 
candidates, and estimating where the GCPs should fall in those images. Correlator3D™ relies on 
the exterior orientation parameters and camera calibration data located in the IEO file. Upon 
entering the GCP Editing tool, the software will verify the average residual error and suggest the 
user to perform an estimation of IEO parameters if this error is too large. This will add an 
“Estimate” AT step to the project tree. When GCP creation is completed and bundle adjustment 
is performed, the “Estimate” step will be automatically removed. Therefore, the “Estimate” step 
has no impact on the bundle adjustment process. The GCP Editing tool is described in Section 10.4. 
 

7.1.3 Tie Point Editing 
 
After the initial automatic tie point extraction step has been performed, the software will display 
links created between images. Hovering the mouse over any link displays the number of tie points 
present between those images.  
 
The user can right-click on any link to visually inspect or edit the tie points between two images, 
ensuring features match in both images.  They can also right-click on the image position to display 
the image itself, with all its feature points displayed as an overlay. 
 
Under some circumstances, it may not be possible to automatically extract tie points between 
some images. This is more likely to occur when the overlap is too low or the quality of images is 
not sufficient. The user can then manually add tie points to the project. A link can be added 
between two images by clicking on the corresponding button, by clicking and holding the left 
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button on the first image and by dragging the link to the second image. The tie point editing dialog 
will appear with the two corresponding images. The user can zoom in using the mouse wheel, and 
pan by clicking and dragging with the center button (wheel).  
 

 
Figure 9:  Tie points between two images. 

 
 
At this point, the objective is to add as many tie points as possible. To do so, the user must right-
click on one feature in one image, and drag it to the corresponding feature in the second image. 
The software will then automatically try to refine the match, and will display the Tie Point Editing 
window. In the window, the user can either validate or refine the position of the feature in each 
image. 
 
A tie point is more beneficial when the feature is identified in multiple images. Due to this, user 
should always consider using such features, distinguished as colored stars in the images. If the 
user clicks on one of these stars, then drags to the corresponding feature in the other image, the 
software will display the Tie Point Editing window. Multiple images containing the feature will be 
displayed. The new observation for the tie point will be identified with its name in blue. 
 
As the user enters more tie points, the software will adjust the relative orientation of the two 
images to facilitate the task. Also, when moving the cursor in one of the two images, the software 
will provide a predictor (shown as a multicolored circle) in the other image to give a hint of where 
the feature should approximately appear. This helps facilitate the process. 
 
At all times, the user can select a tie point to edit by either right-clicking on it, or using the 
corresponding button. 
 
The user can also select a tie point to delete it using the corresponding button. 
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There is no specific rule on how many tie points should be added between two images, although 
5 or 6 is a good approximate. 
 
Note also that the goal is not necessarily insuring that there is a link between every corresponding 
image. For example, adding a link between a pair of images can tie two flight lines together, but 
it is not necessary to link each adjacent images in the flight lines. Instead, the links can be added 
on image pairs that are well dispersed (e.g. one image pair in the beginning, middle, and end of 
the flight lines). This can save the user time, while ensuring that the overall project is connected.  
 

7.1.4 Bundle Adjustment 
 
Bundle adjustment derives adjusted exterior orientation and camera data. Correlator3D™ can be 
used to perform a boresight calibration or a full AT adjustment. In the boresight calibration 
process, the software computes the error component that is common to all exterior orientation 
estimates. This corresponds to the relative position/orientation of the camera to the GPS/IMU 
unit. If a full AT adjustment is selected, then the software still automatically performs a boresight 
calibration beforehand but also computes a unique correction for each individual image. 
 
The software can also be used to perform a camera calibration in parallel to the EO adjustment. 
The software adjusts camera parameters based on the camera type used. These values may 
include focal length, principal point, LUT values, as well as radial and decentering distortion 
parameters. Various camera models are supported and described in Appendix A. 
 
When available, the user can use either ground control points or reference orthos to ensure that 
there is no global spatial offset (i.e. XYZ translation) in the refined values. 
 
When using ground control points, Correlator3D™ takes into account user error when identifying 
the GCP location in the images and also accounts for possible error in the XYZ coordinates.  In the 
bundle adjustment settings, the user may specify uncertainty values for the GCP. The "Pixel 
Radius" is the presumed error when defining the GCP locations in the image using the GCP Editing 
tool. For example, a value of 0.5 means that the user predicts having introduced an error of half 
a pixel when defining the GCP location in the image. 
 
The bundle adjustment settings let the user specify a general uncertainty for the "XY" and "Z" 
components of the GCPs. For example, an uncertainty value of 1m for the "XY" field will allow a 
1m fluctuation to the XY values of the GCPs, whereas a value of 0m implies the user has absolute 
confidence in the GCPs. This will force the software to comply with the GCPs exactly when 
performing an EO adjustment. This setting only applies to GCPs that do not have per-point 
uncertainty values. 
 
Per-point uncertainty values are specified using the GCP Editing tool. Different XYZ uncertainties 
can be specified for each GCP. When available, these values override the aforementioned general 
uncertainty values. 
 
When GCPs are used, final residual analysis and statistics will also be computed for the check 
points. 
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If reference orthos are used, tie points detected in these images will provide horizontal (XY) 
anchoring to the project. If a DEM is currently loaded in the user interface, it will provide vertical 
(Z) anchoring.  While optional, the use of a reference DEM is recommended. 
 
Bundle adjustment can be run in two (2) modes. These are called "Constrained" and 
"Unconstrained" and apply to the camera calibration and EO adjustment settings. The EO 
adjustment setting allows for either a boresight adjustment or a full AT adjustment. The 
unconstrained mode performs all necessary parameter allocations for the user. It is designed to 
provide the fastest AT solution. The constrained mode requires specification of the bundle block 
settings, providing more control over the project.  
 
In the constrained mode, the user can lock one or more parameters for bundle adjustment.  These 
locked parameters can come either from the EO values and/or the camera values. For example, if 
the GPS and camera data are known to be accurate, the user may choose to lock them and only 
process the IMU portion for bundle adjustment. This would force the software to perform bundle 
adjustment only on the IMU portion of the EO values.  
 
In the constrained mode, the user is also required to define a search space for the easting (x), 
northing (y), elevation (z), omega, phi and kappa values. The search space defines the assumed 
uncertainty regarding the accuracy of the input data. For example, specifying an uncertainty of 
5m for easting and an uncertainty of 2° for omega, restricts the software to adjust the easting and 
omega parameters from their current positions as defined by the input to a maximum of 5m and 
2° off respectively, in the output.  
 
Note, in a full AT adjustment, the uncertainty value bounds only the full AT portion of the 
adjustment, meaning only the unique correction for each image will be bound by the uncertainty 
value. The boresight portion of the adjustment, which is automatically performed during any full 
AT adjustment, will not be bound at all. For example, if a 5m value in X was chosen as the 
uncertainty for a full AT adjustment, then as a first step, a common boresight correction of any 
appropriate magnitude (as determined by the software) will be applied to all images followed by 
a unique correction to each individual image of up to 5m in X. The user may change this behavior 
by unchecking the "Perform Boresight Calibration" option. With this option unchecked, the 
software will skip the boresight calibration process, making sure the uncertainty range is 
respected during the adjustment. 
 
The search space must be appropriately large to compensate for the EO errors. Large average 
residuals may imply that the search space was too small and that results are not optimal.   
 
In the case of satellite sensors, the AT process will calculate corrections on RPC values to improve 
the accuracy of the georeference. The software requires overlapping satellite images and RPC 
data.  GCPs may also be used to ensure absolute accuracy.  The EO refinement process will 
automatically adjust the RPC values and output the RMS pixel error. 

7.1.5 Quality Assessment 
 
Once the bundle adjustment has been performed, the user is presented with the overall tie point 
residual error expressed as colored circles centered on each image. There are four different colors: 
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- Green: when the residual error is less than 0.75 pixel 
- Yellow: when the residual error is between 0.75 and 1.5 pixel 
- Red: when the residual error is larger than 1.5 pixel 
- Blue:  when it was not possible to correct the position/orientation of the image (e.g. no 

tie point) 
 
Note that it is normal for the residual errors to be red in the initial step. It simply means that 
bundle adjustment is necessary to bring the values down to the green range. Tie points, ground 
control points and check points, when available, are also displayed using the same color coding. 
By hovering the mouse over a point or an image, the user can see the associated residual error in 
the right hand side of the status bar. 
 
At any time during AT, the user can switch between the color-coded circles and the kappa arrows 
by selecting the corresponding option in the “View” menu. The “IEO Display Style” option applies 
to images while the “GCP Display Style” option applies to GCPs. For GCPs, a third display style is 
also available: Spatial Residuals. 
 
The spatial residual is the difference between the specified coordinates of the GCP and the 
theoretical coordinates that are triangulated using the current IEO data. When the “Spatial 
Residuals” display style is selected, each GCP and check point is represented as a set of two 
arrows. The red arrow shows the vertical residual error. A red arrow pointing up indicates that 
the specified GCP altitude is higher than what is triangulated from the IEO data. The blue arrow 
shows the planar residual error. A blue arrow pointing north-east indicates that the specified GCP 
coordinates are north-east of what is triangulated from the IEO data. 
 
In the software interface, an AT List is displayed on the left hand side detailing the AT steps that 
have been performed. As more bundle adjustments are performed, the list grows displaying all 
iterations. This allows flexibility to back track in case of an undesirable iteration. Specifically, the 
last bundle adjustment operation may be undone or the user may choose to come back to results 
of a specific iteration.  
 
 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         34 
   

 
Figure 10:  Bundle adjustment results. 

 
To provide the user with feedback, detailed aerial triangulation reports are generated outlining 
the statistics on all operations performed. The user has access to a general summary, or more 
detailed reports, such as boresight corrections, image and camera calibration adjustments and tie 
point, image and GCP residuals. At the end of any AT process, the software automatically displays 
a report summarizing the adjustment performed. For convenience, a link to the folder containing 
more detailed AT reports is also provided at the bottom left corner. 
 

7.1.6 Image List Filtering 
 
Before continuing with the rest of the photogrammetric workflow, the user should ensure that 
incorrect images are removed from the project. This will avoid having noise or other artifacts in 
their results. Therefore, the option to select the “Image List Filtering” on the right-hand side is 
available. This tool creates a new AT step in which images having a tie point residual error higher 
than the specified threshold will be removed. The user can see the images being filtered in real-
time as the threshold value is modified.  
 

7.1.7 Coarse DEM Extraction 
 
Once all iterations have been performed and the user is satisfied with the results, the updated 
project can be saved. At this point, the user can create a coarse DEM with the corresponding 
button, and then use that coarse DEM to start DSM generation. For satellite, VM, ADS and large 
frame sensors, and if the terrain is mountainous, it is better to use data such as SRTM. 
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7.2 DSM Generation 

One of Correlator3D™’s main capabilities is the generation of digital surface models (DSM) from 
imagery. The software requires overlapping aerial images and GPS/IMU data.  To determine the 
approximate terrain elevation, a seed DEM covering the project area is required. Although this 
DEM can be coarse, the use of at least DTED Level 2 elevation data or equivalent is suggested.  
However, note that the software can process data even if there is a large difference between the 
input and output DEM horizontal resolution. The coarse DEM can be generated using the AT 
module, or a flat seed can be created using the File menu. 
 
The user must specify the desired output horizontal resolution, or simply request the software to 
calculate an optimal value given the input dataset.  This feature takes into account the project 
parameters (i.e. image resolution, altitude, focal length, etc.) as well as the required processing 
time and then determines the best compromise.  The user can also request the software to 
calculate the maximal value given the input dataset. 
 
Once a horizontal resolution is specified, the user must select a vertical accuracy from the 
corresponding drop-down menu. By default, the lowest accuracy value is selected, leading to 
better processing times. 
 
The user can generate a point cloud by selecting the corresponding option.  It will be generated 
in parallel with the DSM, with virtually no added processing time.  Once the process is completed, 
the point cloud will appear as a sub-item to the DSM in the project tree.  Saving the DSM will 
result in having a LAS file created with the same name on disk. If the user then saves the point 
cloud under a different name than its corresponding DSM, it will be excluded from the project 
tree. Once the point cloud is created, it can be colorized using the Point Cloud Colorizing tool. 
Please refer to section 10.12 for details. 
  
The maximum height variation parameters must also be set.  They represent the level of elevation 
value inconsistency between the original DEM and the one that will be produced from the DSM 
generation process.  One describes the above ground variation while the other describes the 
below ground elevation.  The user should not only consider the errors in the original DEM, but 
also the size of objects in the scene.  As an example, urban areas with tall buildings will require 
the above ground variation parameter value to be high.  Note however, that the higher the values 
are, the longer the processing time is going to be.  While the maximum height variation 
parameters can be set in the DSM generation dialog, it can also be calculated automatically by 
using the corresponding checkbox. 

Images are processed pair-by-pair in the order that they appear in each flight line.  The required 
time is thus directly proportional to the number of images. Processing can be performed on 
multiple machines by taking the exact same project and disabling images through flight lines 
based on the respective divisions. DSM results can then be merged using the DEM Merging Tool 
(see Section 10.5). 
 
An optional 3D constraint file can be provided to Correlator3D™. This file can contain points, lines 
or polygons with elevation (3D) data. Using data values located in the constraint file may result in 
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two benefits. First, it may help the DSM generation process to resolve potential ambiguities, such 
as occluded regions. Second, it will force the output DSM to have the provided elevation values 
at the location of the constraining elements. 
 
If a 3D constraint is provided, Correlator3D™ will force the output values in the DSM to be 
consistent with the provided constraint. However, if the constraint is not consistent with the 
rest of the dataset, it may lead to visual artifacts in the DSM. If such a situation appears, the 
user should make sure that the input DEM and 3D constraint are in the same coordinate system 
(e.g. same datum) and that all input data are valid (e.g. camera calibration or exterior 
orientation parameters). 
 
The software generates a DSM representing all objects in the scene (terrain, vegetation and man-
made structures).  No manual post-processing is necessary to remove pits or spikes: once 
generated, the DSM is ready to use.  Correlator3D™ will generate high quality DSMs across most 
types of surfaces.  However, because of their inconsistent appearance from one image to another, 
water bodies will generally lead to noisy DSM regions.  Note that the overall vertical accuracy of 
the DSM will be displayed once the processing is done. 
 
The following steps must be followed to perform DSM generation: 
 

1. Select the seed DEM you wish to use from the project tree.  
2. Select “DSM generation…” in the “Processes” menu. 
3. If a 3D constraint is used: 

a. Check “3D Constraint”. 
b. Specify the file containing the 3D constraint using the corresponding drop-down 

menu. The constraint will be displayed in the main window overlaid on the DEM. 
4. Specify the desired resolution.  Press the “Optimal” or the “Maximal” button to let the 

program calculate the optimal or maximal value.  Once a resolution is specified, select a 
vertical accuracy from the corresponding drop-down menu. 

5. If a point cloud is required, check “Generate Point Cloud”. 
6. Specify the maximum height variation parameters.  The values should reflect the 

expected discrepancy between the original DEM and the resulting DSM. 
7. Click on the “Processes” button.  Real-time feedback will be provided on the overall 

progress of processing.  
8. Save the generated DSM by selecting “Save DEM As…” using the contextual button in the 

project tree. If a point cloud was generated, it will be automatically saved as a LAS file 
with the same name. 
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Figure 11: DSM generation dialog. 

 
 

7.3 DTM Extraction 

Correlator3D™ features a module to extract a digital terrain model (DTM) from a digital surface 
model (DSM).  Such models are particularly useful for generating orthophotos, as they avoid visual 
artifacts (e.g. along building edges) caused by using DSMs.  The software analyses the DSM and 
automatically removes structures lying on the ground. 
 
In addition to the input DSM, an optional constraint file can be provided to Correlator3D™. This 
file can contain points, lines or polygons with elevation (3D) data. It will force the output DTM to 
have the provided elevation values at the location of the constraining elements. Alternatively, the 
user has the option to provide an exclusion zone. In such a case, the software will extract the DTM 
for all areas minus that of the exclusion zone. 
 
If a constraint is provided, Correlator3D™ will force the output values in the DTM to be 
consistent with the provided constraint. However, if the constraint is not consistent with the 
rest of the dataset, it may lead to visual artifacts in the DTM. If such a situation appears, the 
user should make sure that the input DEM and 3D constraint are in the same coordinate system 
(e.g. same datum) and that all input data are valid (e.g. camera calibration or exterior 
orientation parameters). 
 
The user can also output into a DEM the features that were removed from the DSM.  Note that 
only the DSM features will appear in that DEM.  All other elevation values will be set as undefined. 
 
To create a DTM, follow these steps: 
 

1. Select the DSM you wish to use for DTM extraction from the project tree. 
2. Select “DTM extraction…” in the “Processes” menu. 
3. If a constraint is used: 

a. Check “Constraint”. 
b. Specify the type. Either "Elevation" or "Exclusion Zone". 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         38 
   

c. Choose the file containing the constraint using the corresponding drop-down 
menu. The constraint will be displayed in the main window overlaid on the DEM. 

4. If the DSM features are required: 
a. Check “Output DSM Features”. 
b. Specify the output DEM file using the corresponding drop-down menu. 

5. Click on the “Process” button.  Real-time feedback will be provided on the overall 
progress of processing.  Once the process is done, the DTM will appear in the main 
window. 

6. Save the generated DTM by selecting “Save DEM As…” using the contextual button in the 
project tree.   

 
 

 
Figure 12:  DTM extraction dialog. 

 

7.4 DEM Editing 

While the DSM/DTM generation modules produce highly accurate results, the user may still desire 
to alter results according to their specific requirements. The Correlator3D™ DEM Editing module 
features nine (9) easy to use, yet powerful editing tools: 
 

– Crop an area 
– Delete an area 
– Force the elevation to a user-specified value 
– Offset the elevation by a user-specified value 
– Apply a median or mean filter of user-specified size 
– “Delete and fill” i.e. delete an area and analyze neighboring areas to fill the 

deleted region. 
– DTM Extraction for a user specified area 
– Touch Up small areas  
– Paste an external DEM onto the existing DEM 

 
The aforementioned tools process a user-specified polygonal selection. The time required to 
perform the operations depends on the operation type and the size / complexity of the selection.  
The user can also display orthorectified images or a mosaic as an overlay to the DEM using the 
project tree.  This can facilitate the selection of features like water bodies. 
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To edit a DEM with a user-defined selection the following steps must be performed: 
 

1. Enter the DEM editing module, by selecting “DEM Editing…” in the “Edit” menu. 
The editing toolbar will appear at the right of the window. 

2. Create a selection. 
3. Select an operation to perform in the Edit menu or the DEM Editing toolbar. 
4. Repeat step 2 and 3, as required 
5. Save the edited DEM by selecting “Save DEM As…” using the contextual button in 

the project tree. 
 

7.4.1 Polygonal Selection 
The first step of DEM editing is to make a selection. When the DEM editing mode is enabled and 
the Touch Up tool is not used, a selection can be entered at any time by clicking on the left mouse 
button. Doing so automatically deselects the previous selection and starts a new one. Additional 
left-clicks are necessary to make the selection.  To close the selection, the user must click in the 
vicinity of the initial point or simply right-click. 
 
Correlator3D™ supports single non-self-intersecting polygonal selections. Correlator3D™ will 
refuse to add a point to or close the selection if it makes the polygon to self-intersect. 
 
When the selection is finalized, the user has the option to edit the selection by moving existing 
points or creating new ones. Correlator3D™ computes which DEM cells are considered inside the 
selection. These cells are shaded in gray over the polygonal selection. 
 
A selection can be cleared by pressing the “Escape”. 
 
During a selection, pan operations are supported using the middle (wheel) mouse button.  Placing 
the cursor at the edge of the display area automatically pans the DEM.  
 
Note that zoom operations are not permitted during a selection 
 

7.4.2 Magic Wand 
If instead of a polygonal selection, the user wishes to select features, the magic wand option 
should be used. This option works in a similar manner as the polygonal selection with the only 
difference being that the selection is squeezed automatically to follow the boundary of a feature.  
The user has then the option to edit the selection by moving existing points or creating new ones. 
 

7.4.3 Loading a Selection 
The user can load a selection from a vector file.  This file can contain one or several polygons 
(selections) that will be considered when using one the tools. 
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7.4.4 Saving a Selection 
The user can save a selection to a vector file.  Note that when saving to an existing file, the new 
selection will be appended.  This file can contain one or several selections. 
 

7.4.5 Editing a Selection 
The user can modify the path of a selection using two different tools.  These tools can be accessed 
by clicking on their corresponding buttons in the DEM editing toolbar or from the edit menu. 
 
The first one, the hand tool, is used to move, add, or delete selection points. A point can be moved 
by clicking on its vicinity with the left button of the mouse and dragging it at a new location. 
Conversely, it can be removed by clicking on the right button. New points can be added by clicking 
on the right button of the mouse anywhere on the selection. 
 
Depending on the scale factor, Correlator3D™ will adjust automatically the level of details of the 
selection. Therefore, if the user zooms in the selection, additional selection points will be shown. 
 
The second tool, the scissors tool, is used to remove a series of selection points and replacing 
them with new ones. A first point must be selected with clicking on the left button of the mouse, 
and then a second one to determine the series of points to be removed. New points can then be 
added to follow a new path, starting from the last point to the first one. 
 
The last operation on a selection can always be undone by pressing the corresponding button in 
the mosaic editing toolbar or using the keyboard shortcut “Ctrl-Z.” 
 

7.4.6 Crop 
Correlator3D™ features a polygonal crop tool. Once a polygonal selection is made, the Crop tool 
will discard any elevation values outside the selection. The DEM will also be resized to fit the size 
of the bounding box of the selection. 
 
To use the Crop tool, select “Crop” from the “Edit” menu. 
 

7.4.7 Delete 
The Delete tool discards all elevation values inside the selection, leaving any other value intact.  
 
To use the Delete tool, select “Delete” from the “Edit” menu. 
 

7.4.8 Set Elevation 
The Set and Offset Elevation tools are accessible from the same dialog. 
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Figure 13: Set and offset elevation dialog. 

 
The following is a description of the required settings: 
 
Operation: Decides between a Set Elevation or Offset Elevation function. 
 
Value: New elevation value for the Set Elevation tool or offset value for the Offset Elevation tool. 
 
The Set Elevation operation sets the selected DEM cells to the specified elevation, while the Offset 
Elevation operation offsets the selected DEM cells by the specified elevation. The elevation can 
be a positive or negative fractional value and is specified in the DEM units (meters or feet). 
 
To use the Set Elevation or the Offset Elevation tool, select “Set Elevation…” in the “Edit” menu. 

7.4.9 Filter 
The filter tool applies a mean or a median filter to the selected DEM cells. Cells outside the 
selection and cells located on the border will be used to compute filtered elevation values. 
However, these cells will remain unaffected by the process. Settings can be adjusted using a 
dialog. 

 

 
Figure 14: Filter dialog. 

 
 
 
The following is a description of the required settings: 
 
Filter Type: Decides between mean and median filters. 
 
Filter Size: Diameter of the filter, specified in DEM units (meters or feet). The specified value must 

be an odd multiple of the DEM resolution. 
 
To use the Filter tool, select “Filter…” in the “Edit” menu. 
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7.4.10 Delete and Fill 
Delete and Fill is probably the most useful and powerful editing tool provided by Correlator3D™. 
With a single click, all the selected DEM cells are deleted and replaced by new elevation values 
obtained from an analysis and interpolation of the area surrounding the selection. It requires no 
parameters to be specified and provides excellent results in most situations. 
 
To use the Delete and Fill tool, select “Delete and Fill” from the “Edit” menu. 
 

7.4.11 DTM Extraction 
The DTM Extraction tool extracts the DTM for the selected DEM cells. It uses the same algorithms 
than the DTM extraction process and settings can be adjusted using a similar dialog. Please refer 
to Section 7.3 for further details. 
 

 
Figure 15: DTM extraction dialog. 

 
 
To use the DTM Extraction tool, select “DTM Extraction” from the “Edit” menu. 
 

7.4.12 Touch Up 
The Touch Up tool works in a similar manner than the Delete and Fill tool. Instead of requiring a 
manual polygonal selection, a small fixed-size square selection is automatically performed around 
the location clicked by the user. The tool requires less user interaction and the internal processing 
is optimized for higher performances. Thus, it is a very fast tool to correct small areas. 
 
 
To edit a DEM with the Touch Up tool, the following steps must be performed: 
 

1. First enter the DEM editing mode by selecting “DEM Editing…” in the “Edit” menu. 
The editing toolbar will appear at the right of the window. 

2. Select “Touch Up” in the “Edit” menu. 
3. Click the area to correct. 
4. Repeat step 3, as required. 
5. Exit the DEM editing mode by selecting “DEM Editing…” in the “Edit” menu. The 

editing  toolbar will disappear. 
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6. Save the edited DEM by selecting “Save DEM As…” using the contextual button in 
the project tree. 

 
 
 
 
The size of the square selection is automatically adjusted with the zoom factor used to visualize 
the DEM. If the size is inappropriate for a given situation, the Delete and Fill tool can be used 
instead. 
 

7.4.13 Paste DEM 
The Paste DEM tool replaces regions of the current DEM with a provided DEM. The user can adjust 
the height tolerance parameter that defines the difference in height between the two DEMs for 
which a smooth transition will be calculated. Hence, elevation values showing a difference smaller 
than this value will be averaged in the final DEM. 
 

 
Figure 16: Paste DEM dialog. 

 
 

The Paste DEM tool will not consider any current selection as the input DEM will be pasted entirely. 
 
 
To use the Paste DEM tool, select “Paste DEM” from the “Edit” menu. 
 
 
 
 

7.5 Orthorectification 

Correlator3D™ can generate orthorectified images.  In addition to input images, it requires a DEM 
and exterior orientation parameters.  The user can specify the desired output resolution, or simply 
request the software to calculate the optimal value.  This feature automatically determines the 
ground sampling distance (GSD) of the input imagery. 
 
Correlator3D™ can generate true orthos if a DSM and/or a constraint file is used.  In such a case, 
the orthorectification process will correct for the distortion of buildings and other 3D structures, 
resulting in a true ortho.  Occluded areas which have no image content, e.g. building shadows, 
will be set to black in the final orthorectified image. Note that if a constraint file is inputted, it 
must contain polygons with elevation (3D) data defining the structures. 
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For frame-based sensors, the user can also specify the overlap of the resulting orthophotos. By 
default, the software will suggest the maximal overlap, i.e. the actual overlap between images. 
The user can also select the optimal overlap, which corresponds to 30%. 
 
Choosing a smaller overlap will result in a faster orthorectification, smaller orthophotos on disk 
and ultimately faster mosaic creation.  Note however that reducing the overlap between 
orthophotos will also reduce the area where a mosaic seamline can go through and may therefore 
impact results. 
 
For UAV/medium/large format sensors, the user can crop the image width and height to any user-
defined value. This allows for forward and sidelap control, which may be desirable as a strategy 
to extract the most nadir image portion from the orthophoto. 
 
The better the quality of the inputs, the higher the quality of the resulting final orthophotos. 
Therefore, it is recommended first to perform an aerial triangulation1, a DSM generation and a 
DTM extraction and then use the DTM for producing orthorectified images. 
 
The output format of the orthorectified images is by default tiled with overviews. This should 
not be changed if the user prefers using the Mosaic Editing module afterward to obtain the 
highest performance. 
 
A real-time overview of the orthophotos will be displayed during processing.  Each time an 
orthorectified image is generated, it will appear as an overlay to the currently loaded DEM. 
 
To create orthorectified images, the following operations should be performed: 
 

1. Select the DEM you wish to use for orthorectification from the project tree. 
2. Select “Orthorectification…” in the “Processes” menu. 
3. If true orthorectification is required: 

a. Check “DSM-based” if a DSM is being used for orthorectification. 
b. If a 3D constraint file is used, check "Constraint File" and specify the file using 

the corresponding drop-down menu. The constraint will be displayed in the main 
window overlaid on the DEM. 

4. Specify the desired output horizontal resolution or press the “Optimal” button to let the 
program calculate the optimal value. 

5. In the "Settings", select "Overlap" to specify the desired output overlap percentage. 
Press the “Optimal” or the “Maximal” button to let the program calculate the optimal or 
maximal value. To crop the image width and height, select "Crop" and specify the desired 
percentages. 

6. Specify the format for the orthorectified images. 
7. Click on the “Process” button.  Real-time feedback will be provided on the overall 

progress of processing. 
 

                                                
1 Not supported for ADS and VMA3 sensors. 
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Figure 17:  Orthorectification dialog. 

 
 

7.6 Mosaic Creation 

The mosaic creation module allows for the merging of individual orthorectified images to obtain 
a unique image covering the entire project area. The process is entirely automated. 
Correlator3D™ will select which portion of which image must be included in the final mosaic. Local 
intensity adjustments and seamline generation are performed to provide smooth and seamless 
transitions between adjacent images composing the mosaic. 
 
Before starting the mosaic operation, the user can specify how many blocks to divide the mosaic 
into at minimum. A block is a smaller section or part of the overall mosaic. The purpose of this is 
to support the generation of large mosaics but also to allow multiple users to edit different blocks 
simultaneously after the mosaic has completed. The number of blocks is therefore dependent on 
the user’s choice and project size. The software will create the blocks according to the user's 
selection, but may need to perform further block divisions as necessary. 
 
Selecting the Bound Mosaic Area option allows to generate a mosaic for only a portion of the 
project, as defined by a user created polygons stored in a tile definition file or a Shapefile. The 
user can also specify the size of the feathering zone depending on project type.  The feathering 
zone is the region along a seamline where blending will be applied to ensure a smooth transition 
from one image to the other.  For urban areas, a smaller value is recommended in order to avoid 
ghosting effects along smaller objects like cars.  In other areas like open fields, the value should 
be larger since the content is very similar from one image to the other. The size of the feathering 
zone is specified in pixels.  Note that when editing a mosaic, a different value can be specified for 
each seamline. 
 
Fully automated color balancing can be applied during the mosaic creation process. This balancing 
includes: 
 

­ Brightness and contrast adjustments of each image 

­ Inter-image equalization 
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­ Independent channel analysis for hue equalization 

­ Photometric constraints to maintain global information of brightness, contrast and 
hue 

 
Some projects may include regions where colors are very different from one image to the other 
(e.g. water bodies).  In order to avoid these regions to have too much effect on the color balancing 
results, the user can specify an exclusion zone.  This file can contain several polygons depicting 
the regions to be ignored. 
 
The output of the mosaicing process consists of a single image divided in multiple blocks, 
themselves divided into multiple tiles. Files required to manually edit the mosaic seamlines and 
colors are automatically generated during mosaicing and are stored in subfolders to the mosaic 
folder. The software has therefore its own structure to store the files. Users who desire to specify 
their own mosaic tiling and format have to export the mosaic, either during the mosaic creation 
process, or during mosaic editing. This functionality is described in section 7.7.2. 
 
To create a mosaic, follow these steps: 
 

1. Make sure the project includes orthos. 
2. Select "Mosaic Creation…" in the "Process" menu. 
3. If only some portions of the orthos need to mosaiced, check "Bound Mosaic Area" and 

specify the file using the corresponding drop-down menu. 
4. Specify the size of the feathering zone in pixels. 
5. Specify the minimum number of blocks 
6. If color balancing is required, check "Color Balancing". 
7. If an exclusion zone is specified, check "Exclusion Zone File" and specify the file using the 

corresponding drop-down menu. 
8. If the mosaic needs to be exported after the process, check "Export Mosaic after 

Completion". A dialog will be displayed before the process to specify export options. 
9. Click on the "Process" button.  Real-time feedback will be provided on the overall 

progress of processing. 
 
 

 
Figure 18: Mosaic creation dialog. 
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7.7 Mosaic Editing 

The mosaic editing module allows the auto-generated mosaic to be interactively adjusted 
according to specific user requirements. It provides a smooth interaction with the data and allows 
real-time updating during modifications, without having to regenerate the entire mosaic 
completely. This design reduces the number of manual operations required, significantly 
increasing the overall productivity. 
 
Correlator3D™ also allows for limitless users to simultaneously edit a mosaic without conflicts or 
duplication of any data. Therefore, multiple users can access the same mosaic location, reducing 
significantly storage requirements and leading to fast and efficient operation suited to production 
environments. 
 
To edit a mosaic, please follow these steps: 
 

1. Make sure the project includes a mosaic and the orthos used to generate this mosaic. 
2. Select “Mosaic Editing…” in the “Processes” menu. The mosaic and the corresponding 

blocks will then appear in the main window. 
 

Upon entering mosaic editing mode, users are presented with a view of the entire mosaic and a 
block overlay. The block overlay reveals how the mosaic is split up. This view enables users to 
apply global operations to the entire mosaic area including exporting seamlines, exporting the 
mosaic and manually adjusting the colors. 
 
Users can also edit the auto-generated seamlines by selecting which block(s) to work on. Blocks 
are selected by clicking on them. While each mosaic block can be edited by a single user, different 
mosaic blocks can be edited simultaneously by multiple users. In order to provide multiple users 
seamline editing capability, Correlator3D™ provides an automatic locking system. Blocks already 
in use cannot be selected and will be shaded in red to indicate they are locked by another user. 
Otherwise, if no blocks are in use, then they will all be shaded in green to indicate they are 
available. 
 
Please note, while users do not need to manually select them, all blocks must be available (i.e. not 
locked) to export seamlines, export the mosaic or manually adjust colors. 
 

7.7.1 Export Seamlines 
Users can export the seamlines to an ESRI Shape file by pressing the corresponding button in the 
toolbar. 
 

7.7.2 Export Mosaic 
Users can export the final mosaic using a tile definition file and selecting the type of mosaic they 
want to create. Either a standard mosaic or a NDVI (Normalized Difference Vegetation Index) map 
can be created. If the latter is selected, red and infrared bands must be available in the original 
mosaic. Users can specify different settings for the resulting NDVI map by clicking on the 
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corresponding button, including the type of color map to be used, the number of classes (colors), 
as well as the bounds of the index. 
 
Users can either specify a fixed size for the tiles, or specify individual tile size and coordinates 
through a tile definition file.  If a fixed tile size is specified in the dialog, each tile will have that 
size, except for tiles located on the border of the mosaic.  In such cases, the size of the tile is simply 
reduced to remove unnecessary undefined areas. The tiles are created to be juxtaposed one after 
the other with no overlap between two adjacent tiles. The naming of the tiles describes the spatial 
relation between each other. The name convention is as follows: 
Name_LineNumber_ColumnNumber.tif. 
 
The position and orientation of the input orthorectified images can lead to situations where some 
tiles only contain undefined data (completely black areas). When specifying a fixed tile size in the 
Export Mosaic dialog, if such a situation occurs, the corresponding tiles are not created by 
Correlator3D™. This behavior is part of an optimization effort to reduce memory and disk 
requirements while improving overall performance. 
 
If a tile definition file is used, then the tile size specified will be respected, even if the resulting 
area contains unnecessary undefined areas. Moreover, each tile will be created even if they do 
not contain any data at all. 
 
Users can also export only a portion of the mosaic using the "Crop Area" option, as defined by a 
user created polygon stored in a DGN file or a Shapefile. 
 
To export a mosaic, the following steps must be performed: 
 

1. If a Crop Area is used, specify the constraint file using the corresponding drop-down 
menu. 

2. If a Tile Definition File is used, specify the Tile Definition File using the corresponding 
drop-down menu. 

3. Specify the Mosaic Folder that will contain the mosaic using the corresponding drop-
down menu. 

4. If no tile definition file is used: 
a. Specify the name for the mosaic.   
b. Specify the tile size. 

5. Specify the format for the mosaic tiles. 
6. Click on the “Process” button. The mosaic will then be exported using the parameters 

specified. 
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Figure 19: Export mosaic dialog. 

7.7.3 Adjusting the Colors 
Users can adjust the global colors of the mosaic using the Color Adjustment tool to enhance its 
visual appearance.  This tool allows modifying the levels of the mosaic, i.e. making adjustments to 
the brightness, contrast, and gamma for each individual channel or for all channels together. 
 
In the Channel drop-down list, users can select a color channel to edit.  Depending on the number 
of channels of the imagery, users can choose the "Master" channel to edit the red, green, blue 
and alpha channels all together, or choose "Red", "Green", "Blue" or "Alpha" to edit the channels 
individually.  Note that selecting the "Alpha" channel will also allow users to display this channel 
in the main window.  For grayscale mosaics, only one channel can be selected. 
 
The original histogram of the mosaic for the selected channel is displayed in blue in the dialog, 
while the new histogram to be applied is overlapping in red.  A preview of the adjusted mosaic is 
displayed on the mosaic in the main window.  This option can be toggled at all times in the color 
adjustment dialog. 
 
To increase the contrast of the image, users must drag the input levels sliders, which show the 
image’s brightness values. To darken the darkest values, the left slider must be dragged to the 
right; all values below this value become zero (black). To lighten the lightest values, the right slider 
must be dragged to the left; all values above this value become 255 (white) or 65,535 for 16-bit 
imagery. To change the value of medium grey, the gamma slider must be dragged left or right; 
the range for of the gamma value is 0.1 to 10.0, with 1 being in the middle.  
 
To decrease the contrast, users must drag the output levels sliders. To lighten the darkest pixels, 
the left slider must be dragged to the right. To darken the lightest pixels, the right slider must be 
dragged to the left. 
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For 16-bit imagery, users can activate the "Stretch" mode of the main window.  Doing so when the 
Color Adjustment dialog is displayed will automatically stretch the histogram of the Master 
channel and therefore provide a quick way of adjusting the colors over the 16-bit range. 
 
Adjustments to the mosaic on disk will not be applied until the "Process" button is clicked.  Note 
that once the process is started, it cannot be stopped since all mosaic tiles on disk must be 
adjusted with the same parameters. 
 

 
Figure 20: Color adjustment dialog. 

 

7.7.4 Seamline Editing Mode 
 
After the blocks to be edited have been selected, press the "Seamline Editing" button to enter 
Seamline Editing Mode. 
 
Note that users can toggle back to the mosaic overview to select different blocks by pressing the 
"Block Section" button. 
 
To ensure smooth operation and to minimize memory requirements, it is recommended to select 
the fewest blocks possible when entering into seamline editing mode. 
 
There are two viewing modes in which users can interact with the project. In both modes, users 
can zoom in, zoom out or pan the images the same way they interact with a DEM. The first mode 
displays the chosen blocks and the corresponding seamlines and is used to visually inspect this 
mosaic section and locate seamlines to be edited. 
 
The second mode is used to edit a particular seamline. Users can access this mode by clicking on 
the seamline to be edited. Correlator3D™ will then load the images corresponding to each side of 
the seamline. One side is displayed as a bright image and corresponds to the mosaic region that 
was generated prior the addition of the new orthorectified image. The other side is displayed as 
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a dark image and corresponds to the new orthorectified image that is being added to the mosaic. 
The overlap region between both images is displayed with the original color. 
 
In order to accelerate the loading time, only orthorectified images corresponding to the current 
view region are displayed. Therefore, when editing a seamline, some images may be missing if 
users pan outside the region. 
 
Correlator3D™ displays seamlines according to a particular color scheme. A color is assigned to 
each segment of a seamline depending on its quality, i.e. as determined automatically during the 
mosaic creation. If the software is confident that the seamline follows a path that minimizes the 
artifacts in the final mosaic, it will be green. If not, its color will be red and if the confidence level 
is in between, the seamline will be yellow. Note seamlines that have been previously edited will 
be blue. Users can therefore rely on the color scheme to have a first appreciation of the mosaic 
and determine which seamlines should be edited first. 
 
For 16-bit imagery, users can also stretch the histogram to improve brightness and contrast during 
mosaic editing.  It can be enabled or disabled by selecting “Display Style->Stretch” in the “View” 
menu.  Note that enabling this mode will not modify the colors of the mosaic on disk. 
 
Users can also display the mosaic tile definition by toggling the corresponding button.  The name 
of each tile as well as its boundaries will be displayed as an overlay to the mosaic. If a tile overlay 
was not provided by the user, then this option will instead display the software's own internal tile 
definition for the blocks.  
 

7.7.4.1 Interacting with Seamlines 
Once a seamline has been selected, users can modify its path using two different tools. These 
tools can be accessed by clicking on their corresponding buttons in the mosaic editing tool bar or 
from the edit menu. Users can also switch from one tool to the other by pressing the “Tab” key 
on the keyboard. 
 
The first one, the hand tool, is used to move, add, or delete seamline points. A point can be moved 
by clicking on its vicinity with the left button of the mouse and dragging it at a new location. 
Conversely, it can be removed by clicking on the right button. New points can be added by clicking 
on the right button of the mouse anywhere on the seamline. 
 
Depending on the scale factor, Correlator3D™ will adjust automatically the level of details of the 
seamlines. Therefore, if users zoom in the seamlines, additional seamlines points will be shown. 
 
The second tool, the scissors tool, is used to remove a series of seamlines points and replacing 
them with new ones. A first point must be selected with clicking on the left button of the mouse, 
and then a second one to determine the series of points to be removed. New points can then be 
added to follow a new path, starting from the last point to the first one. 
 
When moving points of a seamline, a red region is displayed around the seamline. This region 
corresponds to the feathering zone, i.e. the region where a progressive transition is made between 
an image and another. Users should take into account this region when defining the path of a 
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seamline since it may result into blurry results in the final mosaic. For example, the feathering zone 
should not pass nearby an object if this object does not appear in both images. 
 
When modifying the path of a seamline, Correlator3D™will automatically update the image to 
represent what the mosaic should look like, without feathering and color balancing being applied. 
 
If there is a seamline traversing multiple blocks, then only the section of the seamline in the 
currently loaded blocks will be available for editing. Furthermore, modifying the point at the 
boundary of the block will not be possible. Likewise, changing the feathering size will not be 
possible unless all the blocks containing the seamline are loaded. 
 
The last operation on a seamline can always be undone by pressing the corresponding button in 
the mosaic editing toolbar or using the keyboard shortcut “Ctrl-Z.” 
 
Users can also modify the size of the feathering zone for a specific seamline.  Once the new size 
has been set, it will first modify the size of the red region that is displayed around a seamline when 
moving its points.  Note that modifying the size of the feathering will have a great impact on the 
processing time when updating the mosaic since it has to be applied on its full length.  Also note 
that the new size only affects the currently selected seamline, and that a different size can be 
specified on every seamline. 
 
Note, the feathering size can only be changed for an entire seamline. Hence, if a block contains 
only part of that seamline, then the feathering size cannot be adjusted. Users will need to load all 
blocks containing a seamline in order to change its feathering size. 
 

7.7.4.2 Updating the Mosaic 
Once users are satisfied with a seamline, modifications must be saved by pressing the 
corresponding button in the mosaic editing toolbar or the keyboard shortcut “Enter”. The display 
will then automatically switch back to the mosaic viewing mode. Each modified segment of the 
seamline will be displayed in blue, and the region of the mosaic that will be affected by the 
modifications will be highlighted in cyan. 
 
Users can then update the mosaic by pressing the corresponding button in the mosaic editing 
toolbar. Correlator3D™ will only process the new region, with feathering and color balancing 
being applied. This functionality removes the necessity of regenerating the whole mosaic and 
allows users to get the final result in a matter of seconds. 
 
Modifications of a seamline can also be discarded by pressing the corresponding button in the 
toolbar or the keyboard shortcut “Esc”. The display will then automatically switch back to the 
mosaic viewing mode with the original seamline being displayed. 
 
Table 5 summarizes the keyboard shortcuts that can be used when editing seamlines. 
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Action Keyboard Shortcut 
Undo the last operation on a seamline Ctrl-Z 
Change current editing tool Tab 
Save modifications to a seamline Enter 
Discard modifications to a seamline Esc 

Table 5:  Keyboard shortcuts for mosaic editing. 
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8. Automated Workflow 

The automated workflow is an automatic solution to the traditional Correlator3D™ data 
production process. This tool is used to perform the complete Correlator3D™ workflow: 
 

­ Aerial Triangulation 
­ DSM Generation 
­ DTM Extraction 
­ Orthorectification 
­ Mosaic Creation 

 
It is important to note that each step is optional; the user selects which processes to automate. 
As seen in the following figure, by simply selecting or de-selecting a checkbox, the user can 
perform desired actions. For example, the user can start the automated workflow from DTM up 
to mosaic only by using the checkboxes. 
 

 
Figure 21: Automated workflow dialog. 

 
The automated workflow creates:  
 

­ Adjusted EO and camera calibration parameters 
­ DSM 
­ DTM 
­ One individual orthophoto for each input image 
­ Orthomosaic 

 
Selecting the “Generate script only” option seen at the bottom of the dialog, the user can create 
a script with the chosen actions. The script can be adapted to specific requirements, where 
variables and parameters can be changed from the default settings. The user can then execute 
the script from the file menu. 
 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         55 
   

A script file (Project.spt) is also created in the output project folder and used by Correlator3D™ 
during the automated workflow. It is possible to manually modify and run the script file. Further 
details can be found in section 11.  
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9. Feature Extraction 

The feature extraction module enables the user to extract 3D features from a DSM by creating 3D 
polygons. Automatic contour detection of buildings and other features enable fast footprint 
collection. Intelligent analysis aids the user while editing features, using the 3D information in the 
DSM to automatically calculate how well planes fit the segmented polygon and providing visual 
feedback. Feedback can also be provided through real-time true orthorectification to achieve pixel 
accuracy. This semi-automatic design saves time over traditional vector extraction methods. 
 
 To extract features, the following operations should be performed: 
 

1. Select the DEM you wish to use for feature extraction from the project tree. 
2. Select “Feature Extraction…” in the “Mode” menu. 
3. Check the Edit/Append box to edit an existing vector file. Specify the vector file using the 

corresponding drop-down menu. The vector file must be an existing ESRI shapefile 
containing 3D information. 

4. Check the "Real-time True Ortho" box to enable this feature.  Specify the DTM file using 
the corresponding drop-down menu. 

5. Click on the “Process” button to start extracting 3D features. The resulting vector 
information will be saved in a new vector file once the user chooses the save option in 
the feature extraction menu. 

 
 

 
Figure 22: Feature extraction dialog. 

 
If loading an existing vector file containing building footprints, the user will need to select/edit 
each building to assign a 3D polygon. 
 
 

9.1 Extraction Modes 

There are four modes in which the user can interact with the DSM. These four modes are based 
on feature type which includes buildings, roads, water bodies and forests. The default mode is 
buildings. The user can switch modes by clicking on the Process menu and selecting the mode of 
choice.  
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9.1.1 Building Extraction Mode 
 
Should the user wish to extract buildings must first ensure they are in the building extraction 
mode. A building is selected in 2 steps. First, pan and zoom to the area of interest. Second, make 
a rough selection around the building by clicking around the building perimeter. The software will 
automatically squeeze the selection around the contour of the building as shown in Figure 23. 
 
The user can go back to the original selection by selecting "Undo" in the "Edit" menu. 
 
 

 
        Figure 23: Contour around a building. 
 
The user then has the option to modify the contour according to their requirements using the 
hand tool. The hand tool is used to move, add, or delete points. A point can be moved by left-
clicking and dragging it to a new location. Conversely, it can be removed by right-clicking with the 
mouse. New points can be added by right-clicking anywhere on the contour. 
 
Holding the control (Ctrl) button while moving a line segment will restrict the movement of that 
segment in such a way that the line segment moves either in a direction parallel to itself or in a 
direction along itself (collinear with itself). A special case occurs when moving an interior line 
segment contained within the building footprint. In this case, the line segment will also resize itself 
to fit within the building footprint. Note, however, the line segment may not resize itself if the 
building footprint is irregular. 
 
The edge merging option is enabled by default. When enabled, edges will be merged together as 
long as they are collinear and represent the same line.  
 
When using the hand tool to add a point, that point may “disappear” if it was added to a straight 
line. This is because the edge merging tool is enabled. The edge merging tool “sees” this point as 
splitting a line segment into two collinear line segments and consequently merges them. Hence, 
the edge merging tool should be disabled to split a straight line into two parts.  
 
All angles of a selected building contour that approach ninety (90) degrees can be rectified. The 
rectify operation changes these angles to be as close to ninety (90) degrees as possible. 
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The software automatically extracts 3D information from the DSM and determines the z-value of 
each vertex of the polygon bounded by the contour. The polygon starts off as a plane representing 
the building. In most cases a building’s roof is more complex than a plane. For these situations, 
the “Add a surface” tool can be used to add further details to the building polygon. The ‘Add a 
surface’ tool is used to segment the building polygon into more planes to better represent the 
roof geometry. To segment the plane, left click and hold on any contour line of a building and drag 
the mouse to see a dotted line indicating the plane segmentation as shown in Figure 24.  
 

 
Figure 24: Plane segmentation indicated by the dotted line. 

 
The newly created dotted line indicates the building polygon is divided into two sections. The 
software automatically recalculates the new plane to be applied to each section and determines 
the z-value of each vertex. It uses the 3D information in the DSM for this calculation. The fact that 
the line is dotted indicates that the two new planes touch at their boundaries (e.g. two planes 
that create a roof slope). If the line was solid it would indicate that the boundary of one plane 
meets the other plane in an area other than the boundary, creating a discontinuity in elevation 
(e.g. when a small building is connected to a taller building). In other words, the software 
automatically uses the building contour (the outer most border of the building) and the dotted/ 
solid lines to fit planes within those boundaries. The user should segment the building polygon to 
create as many planes as necessary to represent all the various slopes in the roof geometry of a 
particular building.  
 
In addition to segmenting planes by clicking on the edges, points can likewise be dragged to divide 
the polygon into different slopes. New points can also be added by right-clicking on the feature 
lines. 
 
If the surface merging option is turned on, planes that are coplanar and that represent the same 
surface will be automatically merged together as the user is modifying the building. 
 
Visual feedback is provided based on how well planes fit within their surfaces. In particular, as the 
user is segmenting the polygon to better define roof geometry, the software automatically 
calculates how well a particular surface can be represented by a single plane. If a plane poorly 
represents a surface, then that plane is shaded red. Likewise, if a plane represents a surface only 
marginally well, then it is shaded yellow. Otherwise, the plane fits a surface well and is shaded 
green. 
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The best fit function uses the information in the DSM to improve the position of the planes. The 
criterion for moving vertices is based on which configuration will result in the best fit for the 
planes. Note this might not necessarily correspond to the best visual positioning of the contour. 
If the position of the points is already optimal, then the best fit function will not perform any 
further changes. 
 
Note that elevation values for each vertex can also be manually set. Use this function to select 
any vertex and change the elevation value. 
 

9.1.2 Road Extraction Mode 
 
This mode allows the user to extract road features. The user traces out the road using the mouse. 
For each vertex of the polygon, the median elevation within a fixed boundary inside the polygon 
is taken as the road height. This accounts for any banking or slopes the road may traverse. 
 

9.1.3 Waterbody Extraction Mode 
 
This mode allows the user to extract water surfaces. The user traces out the water boundary using 
the mouse. For each vertex of the polygon, the median elevation within a fixed boundary outside 
the polygon is taken as the water height. This means that there must be some ground clearing 
around the waterbody in order for the polygon to take on appropriate values. 
 

9.1.4 Forest Extraction Mode 
 
This mode allows the user to extract forests. As in building extraction, this mode uses contour 
fitting. Hence, the user needs only to make a rough selection around the forest area and the 
software will automatically squeeze the selection to the forest boundary. The elevation applied 
will be a local average at each vertex. 
 
Table 6 summarizes the keyboard shortcuts that can be used when extracting features. 
 

Action Keyboard Shortcut 
Switch between Move a Point and Add a Surface Tab 
Surface Merging Ctrl + U 
Edge Merging Ctrl + E 

Table 6: Shortcuts for feature extraction tools 
 
 

9.2 Attributes 

Attributes may be applied to each feature. To apply an attribute to a feature, the user needs to 
first select that feature and enter corresponding information.  New fields can also be created to 
suit the user’s requirements. Moreover, an XML file can be provided containing a user’s desired 
attribute list. The information in this XML file will be loaded automatically. To specify the XML file, 
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please select "Feature Attribute File" in "General Settings" which can be accessed from the "File" 
menu. 
 
 

9.3 Real-time True Orthorectification 

A true ortho can be created for a small region in real-time around a selected feature. To allow for 
true orthorectification, the necessary inputs need to be specified when entering feature 
extraction mode. The user then proceeds to the feature extraction process. At any time, the user 
can enable true ortho generation by toggling the "Display real-time true ortho" button. Note, as 
the user continues editing the selected feature, the true ortho will be automatically updated to 
reflect the changes. This enables the user to iteratively refine the polygon for the selected feature 
until the true ortho is a perfect fit. 
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10. Tools 

10.1 Import EO Data 

Correlator3D™ features a tool to import EO data.  The tool allows to load EO data stored in a file 
(ASCII format) and to arrange it according to the SimActive format.  In the original file, the EO data 
must be ordered by columns and the tool assigns specific columns to particular EO values (i.e. 
image name, easting, northing, elevation, omega, phi and kappa).  The interface also allows some 
rows or columns to be ignored. 
 
The user must specify in which units the angular values are represented (degrees, radians or 
gradians) and the tool will convert them, if necessary, to degrees.  An angular offset can also be 
added to kappa values by using the “Camera Mount Rotation” option.  In addition, if values in the 
“ImageName” column do not include a file extension (e.g. tif, jpg or bmp), then the tool can 
automatically add one using the “Add Extension to Image Name” option.   
 
The user must select a position and orientation system. The software operates using the 
"Easting/Northing" position and the "Omega/Phi/Kappa" orientation systems. However, a 
"Lat/Long" position and/or "Roll/Pitch/Yaw" orientation system may be specified. The tool will 
then perform the necessary conversion. Note, the user must specify a projection to allow 
conversion between different position and orientation systems. The orientation system can also 
be set to "Automatic". This will set omega and phi angle values to zero, and the kappa will be 
derived from the image positions. 
 
Note, that the interface also allows the user to edit a particular cell value and to remove undesired 
lines. 
 
To create an EO file, the user should perform the following operations: 
 

1. Specify an ASCII file by pressing the corresponding "..." button. 
2. Specify the delimiter(s) to be used by the software to recognize the columns in which EO 

data are represented. 
3. Specify the input angular units. 
4. If required, specify a camera mount rotation to add an angular offset to the kappa values. 
5. If required, specify an extension to be added to image names. 
6. Select the appropriate position and orientation system. 
7. If necessary, select the projection. 
8. Assign EO data values to the appropriate columns by pressing on the buttons located at 

the top of the displayed ASCII file.   
9. Remove any undesired rows by clicking on the corresponding check box located at the 

beginning of a line. 
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Figure 25: EO file creation dialog. 

 
 

10.2 Seed DEM Creation 

While it is strongly recommended to use a coarse DEM created using the AT module or at least 
DTED Level 2 elevation data or equivalent as a seed to DSM generation process, Correlator3D™ 
offers a tool to automatically create a seed DEM. The software creates a DEM with the boundaries 
computed from the provided project and with every elevation point set at the specified terrain 
height. 
 
To create a seed DEM, the user should perform the following operations: 
 

1. Select “Seed DEM Creation…” in the “Processes” menu. 
2. Specify the average terrain height. 
3. Click on the “Process” button.  Real-time feedback on the overall progress of processing 

will be provided. Once the process is done, the seed DEM will appear in the main window. 
 
 

 
Figure 26: Seem DEM creation dialog. 
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10.3 Fiducial Detection 

Correlator3D™ features a tool for automatically detecting fiducials.  The tool is useful for 
extracting the position of marks (in pixels), which are necessary for using any processing module 
of the software with scanned films.  The fiducial detection tool is shown to the user when creating 
a project with scanned films.  
     
Correlator3D™ supports fiducial marks that consist of two lines intersected in a perpendicular 
manner.  These two lines can be continuous or not and the corresponding cross mark can be 
oriented in any way.  Also, note that fiducials are assumed to be bright on a black background. 
 
Fiducial detection is performed in four steps: 
 

1. The user enters the required information in the fiducial detection dialog. 
2. The user manually selects the fiducial marks for the first image. 
3. Correlator3D™ automatically detects the fiducial marks for the remaining images. 
4. Correlator3D™ automatically validates the detection results and prompts the user to 

manually select the fiducial marks for faulty images. 
 
Detection results can be verified visually using images that the software automatically generates 
(these can be found in the temporary folder as described in Section 12.3).  The figure below shows 
an example of a successful fiducial detection.  Note that the center of the green mark represents 
the location where the software located a fiducial mark. 
 

 
Figure 27: Sample fiducial detection results. 

 
Fiducial marks that are incorrectly detected can be easily identified by looking at these images.  
The following figure presents such a situation.  In that case, the user should manually correct the 
resulting exterior orientation file.  Note that a warning will be reported in the log file (Section 
12.1) when there was an error in the detection process.  
 

 
Figure 28: Sample fiducial detection results with one mark incorrectly identified. 
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The user can skip the automatic detection phase and manually select the fiducial marks. 
 

To use the fiducial detection tool, the user should perform the following operations: 
 

1. Drag each of the four images until a fiducial mark appears in the center of each frame 
under the green marks. 

2. Check the "Skip automatic detection" if all fiducial marks need to be selected manually. 
3. Click on the “OK” button when all fiducial marks are correctly selected. 
4. Automatic detection is performed and real-time feedback on the overall progress of 

processing is provided. 
5. Automatic detection of faulty images is performed. If necessary (or if the "Skip automatic 

detection" was checked), the fiducial detection dialog for manual selection appears and 
these steps must be performed: 

a. Drag the faulty fiducial marks under the corresponding green marks. 
b. Click the “Next” button. 
c. Repeat steps a) and b) until process is completed. 

 
When using the fiducial detection dialog for manual selection, the size of the fiducial marks can 
be adjusted by using the “+”, “-“ and “1:1” buttons. The fiducial marks are selected by dragging 
their image portion over the intersection of green lines, either by using the mouse or the arrow 
keys on the keyboard. If the arrow keys are used, “Shift” and “Ctrl” keys can serve for coarser, 
but faster positioning, while the arrow keys alone are better suited for fine-tuning purposes. 
 

        
Figure 29: Fiducial detection dialogs for manual selection. On the left, all fiducial marks were 

correctly selected. On the right, a faulty detection must be corrected. 
 
 

10.4 GCP Creation 

Correlator3D™ features a tool to create GCPs for UAV/medium/large format and satellite sensors.  
The GCPs are used during the aerial triangulation process.  The tool enables the user to specify 
pixel coordinates of ground control points in a visual environment. GCPs may be created by 
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specifying their positional coordinates. The software uses these inputs to automatically determine 
which images contain the specified GCP.  These images are then displayed in the visual interface 
and the user is requested to pinpoint the locations of ground control points. 
 
The GCP creation tool is only available in the AT module. 
 

10.4.1 Creating and Importing GCPs 
 
GCPs can be created using the project tree or imported from a text file. To create a GCP, the user 
must hover the cursor over the GCP portion of the project tree, and press the “Add a new point” 
contextual button. When GCPs are already specified in a text file (in ASCII format), they can be 
imported using the project creation wizard or directly in the AT module. The file should be 
organized in columns such that the tool can assign a specific column to a GCP field (i.e. GCP ID, X, 
Y, and Z).  The interface also allows ignoring some rows or columns. Imported GCPs are then 
displayed in the project tree where they must be selected for editing in order to add observation 
data. 
 
The following operations must be performed to import a GCP file: 
 

1. In aerial triangulation mode, select “Import GCP File…” in the “Processes” menu. 
2. Specify an ASCII file by pressing the corresponding "..." button. 
3. Specify the delimiter(s) to be used by the software to recognize the columns in which 

GCP data are represented. 
4. Specify the projection system of the coordinates to be imported. 
5. Choose if the new GCPs should be added to the existing ones or should replace them. 
6. Assign GCP data values to the appropriate columns by pressing on the buttons located at 

the top of the displayed ASCII file.   
7. Remove any undesired rows by clicking on the corresponding check box located at the 

beginning of a line. 
8. Click on the “Import” button. 
9. Add observation data to each GCP by editing them using the corresponding button in the 

project tree. 
 

10.4.2 GCP Editing Dialog 
 
The GCP Editing dialog is used to edit GCP properties, such as its ID, description and coordinates, 
and to tag it in the images. The dialog is divided into four sections: 
 

- Information: this section is located at the top of the window and contains the GCP 
properties. For convenience, it can be collapsed using the blue triangle button in the 
upper-right corner. 

- Observations: this section occupies the largest part of the window. This is where the user 
can adjust the location of the GCP in the images. 
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- Ribbon: this section is located under the observation section. It contains an overview of 
all the observations of the GCP along with other images in which the GCP is likely to be 
found.  

- Zoom and Navigation: this section can be found at the bottom of the dialog. It contains 
controls to help navigate the images. 

 

 
Figure 30: GCP Editing window. 

 
 
There are four (4) GCP types which are "GCP", "GCP_XY", "GCP_Z" and “check point”. The first 
three types are used to distinguish between varying forms of positional certainty. For example, 
the user may need to specify a GCP for which they are only certain about the Z component. In this 
case, GCP type "GCP_Z" will be used. Note, the user will still have to specify an approximate X and 
Y component. The effect of this is that the software will now treat this GCP accordingly in the 
aerial triangulation process, placing a high importance on the Z component, while allowing room 
for error in the X and Y components. Check points are GCPs that are not taken into consideration 
when performing bundle adjustment. They are generally used for quality assessment.  
 

 Certain Uncertain 
GCP XYZ None 
GCP_XY XY Z 
GCP_Z Z XY 

Table 7: GCP type description. 
 
The user has the option to add uncertainty information. As described in in section 7.1.4, when the 
uncertainty values are left blank, the general uncertainty values will be applied during bundle 
adjustment. If an uncertainty value is specified in the GCP Editing dialog, it will overwrite the 
general uncertainty values for this specific point. This way, the user can specify a global 
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uncertainty for all points and redefine it on a point-by-point basis. If uncertainty is used, it must 
be specified for all three coordinates (X, Y, and Z).  
 
Once coordinates are specified, Correlator3D™ will project the point in each image and populate 
the ribbon with the images that most likely contain the GCP. The software uses knowledge on 
already identified GCPs and current IEO parameters to select the best image candidates. 
Consequently, each time a new GCP is added to the project, Correlator3D™ becomes better at 
selecting candidate images.  
 
The observation section of the dialog will display up to three images depending on the window 
size. These are used to adjust the GCP location in each image. Initially, an image candidate has an 
“unspecified” state. This state indicates that the user has not yet validated nor discarded the 
image. To validate an image, the user must adjust the GCP location in that image by clicking and 
dragging the image until the green aim is on top the GCP. 
 
If the GCP is already at the proper location, the image can be validated by pressing the green aim 
button on the top-right corner of the image. 
 
An image can also be discarded by checking the red discard button next to the green aim button.  
 
Unchecking both the aim button and the discard button will revert the image back to the 
unspecified state. Images in the disabled or unspecified state will not be used during bundle 
adjustment as there is no functional difference between both. The disabled state exists to let the 
user differentiate images that have been rejected from those that require attention. 
 
The ribbon is used to navigate around the image candidates. The blue rectangle indicates which 
images are currently displayed in the observation section of the window. To change the images 
being edited, the user can drag and drop the ribbon at the proper location. An alternate option is 
to use the arrows on the left and right side of the ribbon or those under the ribbon. 
 
When the ribbon is dragged completely to the left (therefore showing the rightmost part of the 
ribbon) a special “+” button is visible. Clicking this button will add new image candidates to the 
ribbon. 
 
At any time, the user can jump to a specific image by selecting it in the combo-box located above 
the left image in the observation section of the dialog. If necessary, the image will be added to 
the ribbon. 
 
Each time the location of the GCP is adjusted in an image, the software recalculates the estimated 
location of the GCP in the images marked as “unspecified”. The ribbon is updated in real time to 
reflect these adjustments. This means that each new observation for the GCP improves the 
estimated location of the GCP in the other images. 
 
Scrolling the ribbon is a fast and easy way to identify and validate the GCP observations. 
 
The zoom options located in the lower-left of the window are used to adjust the zoom factor 
applied to the images displayed in the observation portion of the dialog. Cancel and save buttons 
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are located in the lower-right of the window. Clicking “Save and Close” will update the GCP. 
Clicking “Cancel” will discard the changes and close the window.  
 
To edit a GCP, the user should perform the following operations:  
 

1. Fill the required ID (name), type, projection and XYZ coordinates properties. If required, 
add a description and an uncertainty. 

2. Mark which images are to be used with the GCP. 
a. Use the ribbon to navigate between the images. Use the “+” button to add images 

if necessary. 
b. Adjust each image to tag the exact GCP location. Use the zoom options to help 

find the exact location of the GCP. 
3. After all the observations have been added click the “Save and Close” button to update 

the GCP file. 
 
 

10.5 DEM Merging Tool 

Correlator3D™ DEM merging tool allows combining DSM or DTM results that were created 
separately.  It is useful to process a project in multiple parts (e.g. at different times or in parallel 
on multiple machines) and merge different tiles of DEMs together afterward.  It can also help to 
recover intermediate results from individual pairs when, for some reason, the DSM process is 
interrupted.  Correlator3D™ implements an intelligent data fusion approach that leads to 
consistent data sets, even when there are minor discrepancies along adjacent tile boundaries.   
 
The DEM merging tool can be accessed from the Tools menu and does not require any DEM to be 
loaded in the main window.  It can merge files stored in different formats and horizontal 
resolutions.  Note that when merging DEM sets having different horizontal resolutions, the 
resulting data will automatically inherit the finest resolution.  Also, if there is no overlap between 
adjacent data sets, Correlator3D™ will set the corresponding elevation values as undefined.  An 
option to fill gaps in the resulting DEM is also available.  This option allows the user to get a DEM 
in which small areas where elevation values were left undefined are filled with interpolated 
terrain data.  The final merged data will be displayed in the main window and can then be saved 
by the user. 
 
To merge DEMs, the user should perform the following operations: 
 

1. Select “DEM Merging…” in the “Tools” menu. 
2. Specify the files to be merged by clicking on the “Add Files…” button.  A file browser will 

appear.  Select the files to be added and click “Open”.  The list will then be updated.  Note 
that all files can be removed from the list (e.g. in case of an error) by pressing on the 
“Clear List” button. 

3. Click on the “Merge” button.  Real-time feedback will be provided on the overall progress 
of processing.  Once the process is done, the resulting DEM will appear in the main 
window. 

4. Save the merged DEM by selecting “Save DEM As…” in the “File” menu. 
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Figure 31: DEM merging dialog. 

 

10.6 Export DEM Tiles 

Correlator3D™ can divide a DEM in multiple tiles. The user can either specify a fixed size for the 
tiles or specify individual tile sizes and coordinates through a tile definition file.  If a fixed tile size 
is specified in the dialog, each tile will have that size, except for tiles located on the border of the 
DEM.  In such cases, the size of the tile is simply reduced to remove unnecessary undefined areas. 
The tiles are created to be juxtaposed one after the other with no overlap between two adjacent 
tiles. The naming of the tiles describes the spatial relation between each other. The name 
convention is as follows: Name_LineNumber_ColumnNumber.tif. 
 
The shape of the input DEM can lead to situations where some tiles only contain undefined data 
(completely black areas). If such a situation occurs when specifying a fixed tile size in the Export 
DEM Tiles dialog, the corresponding tiles are not created by Correlator3D™. This behavior is part 
of an optimization effort to reduce memory and disk requirements while improving overall 
performance. 
 
If a tile definition file is used, the tile size specified will be respected, even if the resulting area 
contains unnecessary undefined areas. Moreover, each tile will be created even if they do not 
contain any data at all. 
 
The format of the output DEM tiles can be specified in the dialog.  If a definition file is used, the 
format is specified through the extension of the DEM tiles. 
 
The tool can be accessed from the File menu and requires a DEM to be loaded from the project 
tree.   
 
To export DEM tiles, the following operations should be performed: 
 

1. Select a DEM from the project tree.  The DEM will be displayed in the main window. 
2. Select “Export” -> “DEM” -> “DEM Tiles…” in the “File” menu. 
3. If a tile definition file is used 

a. Check “Tile Definition”. 
b. Specify the tile definition file by pressing on the corresponding "..." button. . 

4. Specify the folder that will contain the tiles by pressing on the corresponding "..." button. 
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5. If no tile definition file is used 
a. Specify the name for the mosaic.   
b. Specify the tile size. 

6. Specify the format for the DEM tiles. 
7. Click on the “Process” button.  Real-time feedback will be provided on the overall 

progress of processing. 
 

 
Figure 32: Export DEM tiles dialog. 

 
 

10.7 Export LIDAR LAS and ESRI Shapefile 

Correlator3D™ can export a DEM into a LIDAR LAS file or an ESRI Shapefile.  Using these formats, 
elevation grids will be exported as a series of 3D points.  The tools can be accessed from the File 
menu and requires a DEM to be loaded in the main window.   
 
To export a DEM into the LIDAR LAS or ESRI Shapefile format, the user should perform the 
following operations: 
 

1.  Select a DEM from the project tree.  The DEM will be displayed in the main window. 
2. Select “Export DEM…” in the “File” menu. 
3. Select “Export” -> “DEM” -> “LIDAR LAS File…” or “ESRI Shapefile”   in the “File” menu. 
4. Specify the name and the location of the file to be exported. 

 
 

10.8 Export with Geoid 

Correlator3D™ can export a DEM on which a geoid will be applied.  The geoid file must be provided 
in the GTX file format.  
 
The tool can be accessed from the File menu and requires a DEM to be loaded in the main window.   
 
To export a DEM with a geoid, the user should perform the following operations: 
 

1. Select a DEM from the project tree.  The DEM will be displayed in the main window. 
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2. Select “Export” -> “DEM” -> “With Geoid…” in the “File” menu. 
3. Specify the geoid file by pressing on the corresponding "..." button. 
4. Specify the output DEM by pressing on the corresponding "..." button. 
5. Click on the “Process” button.  Real-time feedback will be provided on the overall 

progress of processing. 
 
 

 
Figure 33: Export with geoid dialog. 

 
 
 

10.9 Export EO and Camera Parameters 

Correlator3D™ can export the EO information and camera parameters. In order to perform this, 
the user must specify a folder in which the information is saved.  In the case of a frame-based 
project, one EO file and one calibration file per camera will be created.  For satellite projects, one 
RPC file will be produced for each image.  These files will be exported as simple text files, which 
can be used later on in the software. 
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10.10 DEM Inspection 

Correlator3D™ DEM inspection tool is used to generate statistics about the quality of a DEM 
against reference data, i.e. elevation points provided in a ShapeFile.  The software automatically 
computes the differences in elevation and provides statistics including bias error, standard 
deviation, RMS error and maximum error. 
 
Statistics are displayed in a window at the end of the process. They can be saved as a text file. 
  
To export DEM tiles, the following operations should be performed: 
 

1. Select “DEM Inspection...” in the “Tools” menu. 
2. Specify the DEM to be inspected using the corresponding drop-down menu. 
3. Specify the reference data using the corresponding drop-down menu. 
4. Click on the “Process” button.  Real-time feedback will be provided on the overall 

progress of processing. 
 

 
Figure 34: DEM inspection dialog. 

 
 

10.11 Change Detection 

Traditionally, change detection is performed by comparing two images.  This approach is not 
robust in general since only changes in the appearance of the scene are detected and such 
changes do not necessarily imply structural changes.  Correlator3D™ allows change detection by 
comparing DEMs instead of images.  Such a comparison is possible since the software can quickly 
and automatically process 3D data. 
 
Correlator3D™ requires two DEMs, which should be generated from two different image sets of 
the same area.  It performs a comparative analysis and determines in 3D the importance of 
changes.  The software outputs change detection results as a DEM with values corresponding to 
the differences in elevation between the two DEMs.  The results can be optionally outputted as 
color information superimposed on a mosaic of orthophotos.  This mosaic gets converted to 
grayscale and structural changes are highlighted using a specific color scheme: negative elevation 
changes (e.g. objects that have disappeared) are displayed in tones of yellow to red according to 
their importance (small to large changes respectively) while positive elevation changes (e.g. new 
objects) are shown in tones of dark to light blue (small to large changes respectively).  A detection 
range in meters is used and only changes that are within the specified range (vertically) will 
appear. 
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To perform change detection, please follow these steps: 
 

1. Select “Change detection…” in the “Tools” menu. 
2. Specify the reference DEM (i.e. the DEM as it appears before changes) using the 

corresponding drop-down menu. 
3. Specify the comparison DEM (i.e. the DEM as it appears after changes) using the 

corresponding drop-down menu. 
4. If a change detection mosaic is required: 

a. Check “Display Changes on Mosaic”. 
b. Specify the “Input Mosaic File” of the input mosaic using the corresponding drop-

down menu.  This file can be either a mosaic definition file or a tile definition file. 
Change detection results will be overlaid on the mosaic after the processing is 
completed.  This mosaic can correspond either to the images taken before or 
after the changes. 

c. Specify the folder where the change detection mosaic will be generated using 
the corresponding drop-down menu.   

If new 3D structures are mostly expected then the mosaic corresponding to the image 
data taken after changes should be used.  If it is anticipated that structures have in 
general disappeared, then the input mosaic should consist of the image data collected 
before changes have occurred. 

5. Specify the detection range.  This implies that only changes within that range (vertically) 
will be detected. 

6. Click on the “Process” button.  Real-time feedback will be provided on the overall 
progress of processing.  Once the process is done, the change detection DEM will appear 
in the main window. 

7. Save the DEM by “Save DEM As…” in the “File” menu. 
 

 

 
Figure 35: Change detection dialog. 
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10.12 Point Cloud Colorization 

The Correlator3D™ point cloud colorization tool is used to colorize a point cloud using a mosaic. 
The software automatically determines correspondence between 3D points and pixels. 
 
When colorizing a point cloud, it is strongly recommended to use an appropriate mosaic. As an 
example, if a point cloud was generated for a dense urban area, then the mosaic should be 
generated using true orthos, i.e. orthos generated on a DSM. Otherwise, discrepancies could be 
observed between points and colors. 
 
To perform point cloud colorization, the user must follow the listed steps: 
 

1. Select the point cloud to be colorized from the project tree. 
2. Select “Point Cloud Colorization” in the “Tools” menu. 
3. Save the modified point cloud by selecting “Save point cloud As…” using the contextual 

button in the project tree. Note that if the point cloud is saved under a different name 
than its corresponding DEM, it will be excluded from the project tree. 

 
 

10.13 DEM Contour Extraction 

The Correlator3D™ DEM contour extraction tool is used to generate equally spaced contour lines 
from the currently loaded DEM and save them in a vector file. The contour lines are extracted 
based on two parameters: the interval, which corresponds to the elevation interval between 
contour lines, and the offset, which corresponds to the offset from zero relative to which to 
interpret intervals. 
 
To perform DEM contour extraction, the user can follow the listed steps: 
 

1. Select the DEM you wish to use for contour extraction from the project tree. 
2. Select “DEM Contour Extraction…” in the “Tools” menu. 
3. Specify the contour interval and offset. 
4. If a specific elevation attribute is required in the vector file, check the “Elevation 

Attribute” option, and specify the name of the attribute. 
5. Click on the “Process” button.  Real-time feedback will be provided on the overall 

progress of processing.  
6. Save the generated contour by selecting “Save contour” using the contextual button in 

the project tree.   
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Figure 36: DEM contour extraction. 
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11. Script Mode 

Correlator3D™ includes a scripting mode for advanced users who desire to fully automate their 
processing tasks.  A script simply consists of a plain text file containing a series of instructions that 
the software will execute sequentially.  The syntax is very simple: each operation starts with the 
process name and all necessary input/output parameters are then specified.  Here is an example 
for a DSM generation process: 
 

<DSMGeneration> 
{ 

  InputDEM   C:\MyFrameBasedProject\DEM\InputDEM.asc 
  InputEO   C:\MyFrameBasedProject\EO\ IEO_AT.ieo 
  Resolution   Optimal 
  AboveGroundVar  50 
  BelowGroundVar 15 
  OutputDEM   C:\MyFrameBasedProject\DEM\DSM.asc 

} 
 
Note that the order in which the process parameters are specified is not important.  The user can 
perform as many operations as desired. Input files that do not exist can be specified as long as 
previous operations create them.  For DSM generation and orthorectification, the optimal 
resolution or overlap can be set by entering "Optimal" (not case sensitive) in the corresponding 
field. Similarly, the user can set the maximal resolution by entering “Maximal” in the 
corresponding field.  A description of the format of script files is included in Section 0. 
 
Once a script file is created, it can be run by selecting “Run Script…” in the “File” menu.  Real-time 
feedback on the overall progress of processing is provided during execution. 
 
Please refer to Appendix A for the script format description. 
 

11.1 Command Prompt 

Instead of using the GUI to interact with Correlator3D™, the user may wish to use a command 
prompt to run individual scripts and batch files quickly. Navigate to the Correlator3D folder and 
type “C3D” to display the possible options. For example, the following command: 
 

C:\Program Files\SimActive\Correlator3D\C3D 
 
will display the possible options on the command prompt screen provided the software was 
installed in that directory.  
 
To run a script: 
 

 C:\Program Files\SimActive\Correlator3D\C3D /f PathToMyScript 
 
The “/f” must always precede the path to the script. The list of commands is summarized in Table 
8:  
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Command Action 
/f Operator preceding path to the script or batch file 
/v Outputs all messages  
/m Outputs only the main messages 
/p Outputs progress percentage to the screen 
/r Saves message content to a file 

Table 8: Command line operations summary. 
 
As another example, consider the following command: 
 

C3D.exe /f PathToMyScript.spt /v /p /r FileLog.txt 2>> Errors.log 
 
This will make C3D.exe process the script file "PathToMyScript.spt". Since the “/v” command was 
used, all the levels of information will be outputted. Normally, this information would be 
displayed onscreen. However, the “/r” redirects this information to the file “FileLog.txt”. The “/p” 
command outputs the progress of each operation in the script. This information is only displayed 
onscreen and will not be redirected by the /r” command. Lastly, the “2>>” is a batch command 
that will append error messages if any to the file "Errors.log". 
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12. Troubleshooting 

12.1 Log Window and Log File 

Correlator3D™ includes detailed warning and error messages to facilitate troubleshooting.  In 
addition, all major operations performed during processing are displayed in the log window.  This 
window is fully dockable, allowing the user to customize their Correlator3D™ environment.  
Warning and error messages are color-coded in yellow and red respectively. 
 

 
Figure 37: Log window. 

 
The content of the log window is automatically saved in a log file.  This can be particularly helpful 
if, for some reason, the processing is interrupted.  The file is located in the folder “My 
Documents\SimActive\Correlator3D\” and named “Correlator3D_Log.xml”.  The file can also be 
accessed directly from the user interface by selecting “Log File” from the “Help” menu.  A new log 
file is created each time the software is launched and logs information until the program is closed.  
Copies of the ten most recent log files are automatically stored in the folder “My 
Documents\SimActive\Correlator3D\History\”. 
 
 

12.2 Good Practice 

As a first step, the user should perform a test on a few images before processing an entire project.  
This will ensure that there is no problem with the input data.   It will also allow verifying that both 
the results and the required processing time meet expectations.  Input parameters (depending on 
the module used) can be varied, and small scale tests can be repeated until satisfactory results 
are produced.  Note that this recommendation does not hold for the aerial triangulation module, 
as it requires as much input data as possible. 
 
If Correlator3D™ is provided with an input DEM that is smaller than the area covered by the image, 
only the portion of the image covered by the DEM will be processed. This can be helpful to make 
smaller and thus faster tests. 
 
 

12.3 Temporary Files 

Different temporary files are created during data processing.  In the case of the DSM generation 
process, each individual file, which is stored in the SimActive model format (.smf files), contains 
DSM generated from a given pair.  Temporary files are named according to the first image of the 
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pair processed.  At the end of the DSM generation process, these individual files are automatically 
merged together to produce a single DSM. 
 
If the DSM generation process is interrupted in the middle of a large batch process, then these 
files can be retrieved and merged manually using the DEM merging tool.  The user can change the 
location of the temporary folder by selecting “General Settings” from the “Settings” menu and 
changing its location.  For best software performance, this folder should be located on a separate 
local hard drive, different from the one where input/output data are stored. 
 
In the case of the fiducial detection process, a visual representation of the results is also created.  
For each input photo, an image showing the four detected marks is stored for visual validation.  
These images are named according to input image. 
 
 

12.4 Common Problems 

The following is a list of problems that may occur as well as checklists to determine their causes: 
 
1. The processing time required to generate results is too long. 
 

­ Verify that the requested data resolution is not too small.  When using the DSM 
generation module, it is recommended that the software calculates the optimal 
value (returning the best compromise between resolution and processing time). 

­ When using the DSM generation module, verify that the “Max Height Variation” 
parameters are realistic and not too high. If the “Automatic” option was selected, 
verify the log to make sure that these values were not too high during the process. 

­ Split the project in multiple parts and process them in parallel on several 
machines. 

­ Always perform a small scale test on a few images to assess the required 
processing time before processing a larger image set. 

­ Ensure that an appropriate graphics card is used. 
­ Verify that the data are stored on local hard drives as opposed to network drives.  

Ideally, a different hard drive should be used for temporary files created during 
processing. 

 
 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         80 
   

2. Buildings or other structures seem to be “chopped” or noisy in DSM model. 
 

­ Ensure that the “Max Height Variation” parameters used for generating the DSM 
were appropriate.  This number should reflect the expected variations in the 
height of objects.  If the area contains large building or tall trees, then the above 
ground variation should be set to a higher value. 

 
3. The 3D constraint creates “ditches” in forest areas. 
 

­ Depending on the forest density, Correlator3D™ DSM generation module may 
return the elevation of the canopy of the forest. 3D constraint elements 
representing ground elevation values may thus force Correlator3D™ to create such 
“ditches” in dense areas. To get a more homogeneous DSM, the user can simply 
remove the constraint elements causing problems from the 3D constraint files. 

 
4. Delete and Fill does not give the expected results. 
 

­ The Delete and Fill tool analyses DEM cells that are adjacent to the selection. Make 
sure that the selection is large enough to include all DEM cells to be removed, but 
that it is small enough not to include other elements. For example, if a building is 
to be removed, the selection must include that building, but must not include 
another building. 

 
5. Editing mode is activated but polygonal selections cannot be created. 
 

­ Make sure the Touch Up mode is not activated. 
 

6. There are visual artifacts along edges of structures (e.g. buildings) in the orthophotos. 
 

­ Such artifacts are usually caused by using a DEM with a lower resolution than the 
desired orthorectified images.  This can be avoided by using a DTM instead of a 
DSM. 

 
7. Some tiles of the mosaic are not created. 
 

­ The position and orientation of the input orthorectified images can lead to 
situations where some tiles contain only undefined data (completely black areas). 
When such a situation occurs, the corresponding tiles are not created by 
Correlator3D™. This behavior is part of an optimization effort to reduce memory 
and disk requirements while improving overall performance. 
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13. Appendix A 

13.1.1.1 Camera Calibration Types 
 
Correlator3D™ supports four types of camera calibrations.  
 

1. Digital Sensors 
 
The first calibration type, designed for metric cameras, simply consists of providing the following: 
 

­ Image width in pixels 
­ Image height in pixels 
­ Pixel size in microns 
­ Focal length in millimeters 
­ Principal point coordinates in millimeters 

 
Note that the imagery is assumed to be already corrected for distortion. 
 

2. Digital Sensors with Distortion Table 
 
The second calibration type is meant to specifically support camera systems using a distortion 
table.  The difference in the calibration file is that radial lens distortion is taken into account when 
processing imagery.  The parameter values are thus defined as a look-up table (LUT) .  These values 
specify radial distortion as a function of the pixel distance from the image center. 
 

3. Scanned Films 
 
The third calibration type, designed for scanned films, contains additional fields (compared to the 
digital sensor type) consisting of the coordinates in millimeters of the following: 
 

­ Bottom-left fiducial 
­ Top-right fiducial 
­ Top-left fiducial 
­ Bottom-right fiducial 

 
Positions of fiducials and the principal point should be referenced to the principal point of 
autocollimation as the origin.  
 

4. Polynomial  
 
The fourth calibration type specifically supports camera systems with radial and decentering lens 
distortion. The parametric distortion model is defined by the following equations, where X and Y 
are measurements in mm referring to the principal point and r=√(X2 + Y2):  
 

dX = dXradial + dXdecentering, 
dY = dYradial + dYdecentering, 
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where, 
 

dXradial = X (K0 + K1*r2 + K2*r4 + K3*r6 + ... + K7*r14), 
dYradial = Y (K0 + K1*r2 + K2*r4 + K3*r6 + ... + K7*r14), 
dXdecentering = (1+P3*r2+P4*r4)*(P1*(r2+2*X2)+2*P2*X*Y), 
dYdecentering = (1+P3*r2+P4*r4)*(P2*(r2+2*Y2)+2*P1*X*Y), 

 
and, 
 

K0 to K7 are parameters associated with the radial distortion, 
P1 to P4 are parameters associated with the decentering distortion. 

 

13.2 Tile Definition File 

A tile definition file can be inputted in Correlator3D™ Mosaic Creation module to define the name, 
the coordinates and the size of each mosaic tile. A tile is defined by two corners located on the 
diagonal of its area. Each tile is specified on a separate line containing the following five (5) fields: 
 

­ Tile filename 
­ X coordinate of the first corner defining the tile area 
­ Y coordinate of the first corner defining the tile area 
­ X coordinate of the second corner defining the tile area 
­ Y coordinate of the second corner defining the tile area 

 
Corners can be specified in any order, as long as they are located on a diagonal. 
 
Sample: 
 
*********************************************************************** 
 SimActive Tile Definition File 
 Copyright(c) 2009 SimActive Inc. 
 All rights reserved. 
*********************************************************************** 
# Tile Name       First Corner (x,y) Second Corner (x,y) 
TileName_01  446762.0 5032005.0 447170.0 5031653.0 
TileName_02  447170.0 5032205.0 447643.0 5031415.0 
TileName_03  446862.0 5031653.0 447170.0 5031415.0 
TileName_04  447061.0 5031415.0 447351.0 5031120.0 
TileName_05  446762.0 5030920.0 447351.0 5031120.0 
 
 
 

13.3 Script Format Description 

This section describes the operations and parameters available in a Correlator3D™ script. 
 
Script syntax is the following: 
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<OperationName> 
{ 
 ParameterName ParameterValue 
 ParameterName ParameterValue 
 ... 
 ParameterName ParameterValue 
} 
 
The script file is case insensitive. This means that “DTMExtraction” and “dtmextraction” are both 
valid. 
 
The name of the operations must appear between ‘<’ and ‘>’ marks. And the parameter lists is 
delimited by a pair of braces (‘{‘ and ‘}’). 
 
There is no limitation on the number of white spaces (spaces, tabs and new lines) as long as the 
ParameterName and its ParameterValue are on the same line. 
 
Comments can be added in the file. Each line of comment must be preceded with ‘#’.  
 
OperationName can be one of the following: 

 AerialTriangulation 
 DSMGeneration 
 DTMExtraction 
 Orthorectification 
 MosaicCreation 
 ExportMosaic 
 ChangeDetection 
 DEMMerging 
 DEMTiling 
 DEMInspection 
 ExportGeoidDEM 
 PointCloudColorization 

 
The list of parameters and acceptable values varies according to the operation.  For a given 
operation, the order of the parameters has no importance.  The description of each available 
parameter follows. 
 
Parameters for AerialTriangulation 
 
 

Parameter name Type Description 
TiePointExtraction ‘On’, ‘Off’ Indicates if tie point extraction 

must be performed. 
CameraCalibration ‘None’, ‘Constrained’, 

‘Unconstrained’ 
Indicates the type of camera 
calibration. 

EOAdjustment ‘None’, 
‘BoresightCalibration’,  

Indicates the type of EO 
adjustment. 
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‘ConstrainedAT’, 
‘UnconstrainedAT’ 

PerformBoresight ‘On’, ‘Off’ Bound boresight within total 
uncertainty. Only required if 
EOAdjustment is 'ConstrainedAT' 

ExtractionType ‘Standard’, ‘Exhaustive’ Type of tie point extraction to 
perform. 

InputEO String  Path to the input interior/exterior 
orientation file. 

GCPFile String  Optional. Path to the input 
ground control point file. 

InputDEM String Optional. Path to the reference 
DEM. Required for satellite 
projects. 

ReferenceORIList String Optional. Path to the reference 
ORI file. 

AdjustFocalLength ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment. 

AdjustXmm ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment. 

AdjustYmm ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment. 

AdjustK0 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK1 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK2 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK3 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK4 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK5 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         85 
   

adjustment for odd/even order 
polynomial distortion model. 

AdjustK6 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustK7 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustP1 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustP2 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustP3 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustP4 ‘On’, ‘Off’ Optional. Indicates if parameter 
will be adjusted during bundle 
adjustment for odd/even order 
polynomial distortion model. 

AdjustLUT ‘On’, ‘Off’ Optional. Indicates if parameters 
will be adjusted during bundle 
adjustment for LUT distortion 
model. 

AdjustX Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustY Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustZ Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustOmega Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustPhi Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         86 
   

AdjustKappa Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustGCPXY Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustGCPZ Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

AdjustGCPObs Float Optional. Expected uncertainty in 
parameter to be adjusted during 
bundle adjustment. 

ATFolder String Path to the AT folder. 
OutputEO String  Path to the output 

interior/exterior orientation file. 
OutputDEM String Path to the output seed DEM file. 

 
 
Parameters for DSMGeneration 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
InputEO String Path to the input interior/exterior orientation file. 
Resolution Float, 

‘Optimal’, 
‘Maximal’ 

Required resolution of the resulting DSM. 

VertAccuracy Float, 
‘Optimal’, 
‘Maximal’ 

Required vertical accuracy of the resulting DSM. 

GeneratePointCloud ‘On’, ‘Off’ Optional. Indicates if a point cloud must be 
generated. 

AboveGroundVar ‘Automatic’, 
Integer 

Expected discrepancy between the original DEM 
and the resulting DSM (above ground). 

BelowGroundVar ‘Automatic’, 
Integer 

Expected discrepancy between the original DEM 
and the resulting DSM (below ground). 

OutputDEM String Path to the output DSM file. 
3DConstraintFile String Optional. Path to the 3D constraint file. 

 
 
Parameters for DTMExtraction 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
3DConstraintFile String Optional. Path to the 3D constraint file. 
ConstraintType 'Exclusion', 

'Elevation' 
Optional. Type of constraint to be used. 
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DSMFeatures String Optional. Path to the output DEM. 
OutputDEM String Path to the output DTM file. 

 
 
Parameters for Orthorectification 
 

Parameter name Type Description 
InputDEM String Path to the DEM file. 
InputEO String Path to the input interior/exterior orientation file. 
DSMBased ‘On’, ‘Off’ Parameter used to generate true orthos from a DSM. 
3DConstraintFile String Optional. Parameter used to generate true orthos 

using a 3D constraint file. 
OutputORIFolder String Path to the output folder. 
Resolution Float, 

‘Optimal’ 
Required resolution of the orthorectified images. 

Overlap Integer, 
‘Optimal’, 
‘Maximal’ 

Required overlap between orthorectified images. 
Must be commented out if CropWidth and 
CropHeight are specified. 

CropWidth Float Image crop width. Must be commented out if 
Overlap is specified. 

CropHeight Float Image crop height. Must be commented out if 
Overlap is specified. 

OutputFormat ‘GeoTIFF’, 
‘TFW’ 

Output format of the orthorectified images. 

TiledTiff ‘Tiled’, 
‘Untiled’ 

Indicates if the orthorectified images must be tiled or 
untiled. 

Overviews ‘On’, ‘Off’ Indicates if the orthorectified images must be 
generated with overviews. 

 
 
Parameters for MosaicCreation 
 

Parameter name Type Description 
InputORIList String The default file name is the name of the IEO file used 

to orthorectify the images. 
MosaicArea String Optional. Path to the tile definition or vector file. 
OutputFolder String  Path to the output folder. 
MosaicName String Name of the mosaic. 
Feathering Integer Optional parameter. Default value is 37. 
MinNumBlocks Integer Optional parameter. Default value is 1. 
ColorBalancing ‘On’, ‘Off’ Indicates if color balancing must be applied. 
ExclusionZone String Optional. Path to the vector file. The exclusion zone 

file is only considered when color balancing is on. 
 
 
 



Correlator3DTM User Manual 
 

© 2016 SimActive Inc.  All rights reserved.         88 
   

Parameters for ExportMosaic 
 

Parameter name Type Description 
BlockDefFile String Path to the mosaic definition file. 
MosaicType ‘Standard’, 

‘NDVI’ 
Type of the mosaic to be created. 

OutputFolder String Path to the output folder. 
TileDefFile String Optional*. Path to the tile definition file. 
MosaicName String Optional*. Name of the output mosaic. 
TileWidth Integer Optional*. Tile width in pixels 
TileHeight Integer Optional*. Tile height in pixels 
OutputFormat ‘GeoTIFF’, 

‘TFW’ 
Output format of the mosaic tiles. 

TiledTiff ‘Tiled’, 
‘Untiled’ 

Indicates if the orthorectified images must be tiled 
or untiled. 

Overviews ‘On’, ‘Off’ Indicates if the orthorectified images must be 
generated with overviews. 

ColorMap ‘Beige to 
Dark Green’, 
‘Dark Blue to 
Dark Green’, 
‘DEM Color 
Style’, 
‘Grayscale’, 
‘Red to Blue’ 

Optional**. The color map to be used. 

InvertColorMap ‘On’, ‘Off’ Optional**. Invert the color map. 
MinimumThreshold Float, 

‘Optimal’ 
Optional**. Minimum bound of the NDVI index. 

MaximumThreshold Float, 
‘Optimal’ 

Optional**. Maximum bound of the NDVI index. 

ClassCount Integer Optional**. Number of classes for the index. If 
omitted, the mapping is continuous. 

*Either TileDefFile or MosaicName, TileWidth and TileHeight can be specified. 
**Must be defined when mosaic type is set to NDVI. 
 
 
Parameters for ChangeDetection 
 

Parameter name Type Description 
ReferenceDEM String Path to the DEM file before the changes. 
ComparisonDEM String Path to the DEM file after the changes. 
MinimumThreshold Float Minimum detection threshold (in model units). 
MaximumThreshold Float Maximum detection threshold (in model units). 
OutputDEM String Path to the output DEM file. 
BlockDefFile String Optional. Path to the block definition file. 
OutputFolder String Optional. Path to the mosaic output folder. 
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Parameters for DEMMerging 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
InputDEM String Path to the input DEM file. 
InputDEM String Path to the input DEM file. 
FillGaps ‘On’, ‘Off’ Indicates if the gaps in the resulting DEM must be 

filled. 
OutputDEM String Path to the output DEM file. 

 
 
Parameters for DEMTiling 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
OutputFolder String Path to the mosaic output folder. 
TileDefFile String Optional*. Path to the tile definition file. 
DEMName String Optional*. Name of the output mosaic. 
TileWidth Integer Optional*. Tile width in pixels 
TileHeight Integer Optional*. Tile height in pixels 
OutputFormat ‘GeoTIFF’, 

‘AsciiGrid’, 
‘SMFFormat’ 
'Shapefile' 
'LIDARLAS' 

Format of the output DEM tiles. 

*Either TileDefFile or DEMName, TileWidth and TileHeight can be specified. 
 
 
Parameters for DEMInspection 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
ReferenceData String Path to the reference data file. 
OutputFile String Path to the output statistics file. 

 
 
Parameters for ExportGeoidDEM 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
GeoidFile String Path to the geoid file. 
OutputDEM String Path to the output DEM file. 
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Parameters for PointCloudColorization 
 

Parameter name Type Description 
InputPointCloud String Path to the input point cloud file. 
BlockDefFile String Path to the mosaic file. 
OutputPointCloud String Path to the output point cloud file. 

 
 
 
Parameters for DEMContourExtraction 
 

Parameter name Type Description 
InputDEM String Path to the input DEM file. 
Interval Float Interval between contours (in model units). 
Offset Float Offset from zero relative to which to interpret 

intervals (in model units). 
ElevationAttribute String Optional*. Name of the attribute containing the 

elevation. 
OutputFile String Path to the output contour file. 

 

 


